Micro Focus Visual
COBOL 5.0 for ISVs

Release Notes

Micro Focus
The Lawn
22-30 Old Bath Road
Newbury, Berkshire RG14 1QN
UK
http://www.microfocus.com

© Copyright 2020 Micro Focus or one of its affiliates.

MICRO FOCUS, the Micro Focus logo and Visual COBOL are trademarks or registered
trademarks of Micro Focus or one of its affiliates.
All other marks are the property of their respective owners.
2020-05-13

ii

Contents
Micro Focus Visual COBOL 5.0 for ISVs Release Notes .................................4
What's New ......................................................................................................... 6
.NET Core Support ............................................................................................................. 6
COBOL Formatting ............................................................................................................. 6
Code Analysis ..................................................................................................................... 6
Enterprise Server Common Web Administration
............................................................... 7
COBOL Language Enhancements ......................................................................................7
Compiler Directives ............................................................................................................. 8
Consolidated Trace Facility (CTF) ....................................................................................... 8
Data File Tools .................................................................................................................... 8
Database Access ................................................................................................................ 8
Database Connectors ......................................................................................................... 9
Debugging ...........................................................................................................................9
Eclipse Integration .............................................................................................................10
Enterprise Server Security ................................................................................................ 11
Micro Focus Unit Testing Framework ................................................................................ 12
Platform Support ............................................................................................................... 12
Product Documentation .....................................................................................................12
Visual Studio Integration ................................................................................................... 12

Significant Changes in Behavior or Usage ....................................................14
Known Issues ................................................................................................... 18
Resolved Issues ............................................................................................... 19
Other Issues Resolved in This Release ........................................................ 45
Unsupported Functionality ..............................................................................47
Installation ........................................................................................................ 48
Before Installing ................................................................................................................ 48
Downloading the Product ....................................................................................... 48
System Requirements ............................................................................................ 48
Product Co-Existence .............................................................................................59
Basic Installation ............................................................................................................... 59
Installing Visual COBOL for Visual Studio ..............................................................60
Installing Visual COBOL for Eclipse (Windows) ..................................................... 60
Installing Visual COBOL for Eclipse (UNIX) ........................................................... 60
Installing Visual COBOL Development Hub ........................................................... 61
After Installing ................................................................................................................... 62

Licensing Information

...................................................................................... 63

To buy and activate a full unlimited license ....................................................................... 63
To start Micro Focus License Administration
....................................................................63
Installing licenses .............................................................................................................. 63
If you have a license file ......................................................................................... 64
If you have an authorization code ...........................................................................64
To obtain more licenses .................................................................................................... 66

Updates and SupportLine

................................................................................67

Further Information and Product Support ......................................................................... 67
Information We Need ........................................................................................................ 67
Creating Debug Files ........................................................................................................ 69

Copyright and Disclaimer

................................................................................ 70

Contents | 3

Micro Focus Visual COBOL 5.0 for ISVs
Release Notes
These release notes contain information that might not appear in the Help. Read them in their entirety
before you install the product.
Note:
•

•

This document contains a number of links to external Web sites. Micro Focus cannot be
responsible for the contents of the Web site or for the contents of any site to which it might link.
Web sites by their nature can change very rapidly and although we try to keep our links up-to-date,
we cannot guarantee that they will always work as expected.
Check the Product Documentation section of the Micro Focus SupportLine Web site for any
updates to the documentation which might have been uploaded.

Product Overview
The Micro Focus Visual COBOL for ISVs package comprises the following products which you can
download from your Electronic Product Delivery Note:
•

•

•

Visual COBOL for Visual Studio - delivers the richest development experience for COBOL programming
available on Windows using Microsoft's Visual Studio 2017 or 2019. Visual COBOL supports the
development and deployment of both managed .NET and native COBOL applications.
Visual COBOL for Eclipse - provides an Eclipse-based integrated COBOL development environment for
Windows or Linux. Provides COBOL JVM support and enhanced compatibility with ACUCOBOL. Can
be used standalone for developing local applications or in conjunction with the Development Hub to
develop remote projects in Linux and UNIX.
Visual COBOL Development Hub - provides a rich desktop development environment based on the
Eclipse IDE with high-performance server-based tools for managing builds, source code access and
debugger engine. The Development Hub also provides a central administration site, simplifying the
development tool distribution and maintenance process.

Upgrading from earlier Micro Focus products
This version of your product is dependent on a later version of the Microsoft C run-time system than earlier
Micro Focus products. This means that COBOL executables (.exe) built with a version earlier than 4.0
might not be compatible with the current version of the run-time products. If the behavior of your application
changes with the current version, we strongly recommend that you relink the main executable with the
current version. This will ensure that the COBOL run-time system fully handles any run-time error
conditions that might occur.
A new executable that is fully compatible with the current version can be produced without recompiling the
application, as long as the original object code is available and it is relinked with the current version.
To allow your executables to benefit from the product's latest programming and performance
enhancements, we recommend a full recompilation of your source code.
If you are using Visual Studio, you can configure the IDE to automatically check whether applications
created with older releases must be relinked. If the application uses an older version of the C run-time
system, Visual COBOL can automatically relink the existing executable or .dll to the new version of the C
run-time system without the need to recompile the application first. If a project needs relinking, Visual
Studio displays a message in the status bar providing an option for you to choose and relink the project.
If you are using Eclipse, Visual COBOL can automatically relink existing projects created with Visual
COBOL earlier than 4.0 that have executable link artefacts. Eclipse displays a warning in the Problems
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view that the project requires relinking. It then offers a Quick Fix action for you to execute that will link your
project with the most recent version of the Run-Time System.
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What's New
This release provides enhancements in the following areas:
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

.NET Core Support
COBOL Formatting
Code Analysis
Enterprise Server Common Web Administration
COBOL Language Enhancements
Compiler Directives
Consolidated Trace Facility
Data File Tools
Database Access
Database Connectors
Debugging
Eclipse Integration
Enterprise Server Security
Micro Focus Unit Testing Framework
Platform Support
Product Documentation
Visual Studio Integration

.NET Core Support
Back to Top
.NET Core is an open-source development platform that supports multiple operating systems. You can now
use Visual COBOL to develop a COBOL application then publish it to be deployed on .NET Core.
The following project templates for .NET Core applications are available - Class Library (.NET Core) and
Console App (.NET Core).

COBOL Formatting
Back to Top
You can now reformat your COBOL code in the editor according to your preference and standards.
Formatting sets the indentation based on the configuration options which you can set in Tools > Options >
Text Editor > Micro Focus COBOL > Formatting > Indentation (for Visual Studio) and Windows >
Preferences > Micro Focus > COBOL > Editor > Formatter (for Eclipse).
You can find the COBOL formatting features on the Edit > Advanced menu (for Visual Studio) and editor
context menu (for Eclipse) menu.

Code Analysis
Back to Top
You can now create the following views for your code:
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•

•

Program Flow Graph - enables you to view the overall structure of the COBOL program with nodes
representing sections and paragraphs. PERFORM statements between them which affect the program
flow are represented by links joining the nodes. External calls to other programs are shown but cannot
be expanded in the Program Flow Graph view. Hovering over the nodes shows a tooltip containing the
code representing the respective sections or paragraph. Clicking a node or a link joining said nodes
positions the code editor to that point in the source, allowing quick and easy navigation of the program.
Data Flow Analysis Tree - enables you to select a data item and then either statically trace what might
change its value or what other data items it might affect.

Enterprise Server Common Web Administration
Back to Top
Note: This feature is in Early Adopter Product (EAP) release status.
Visual COBOL now includes a new Enterprise Server Common Web Administration interface (ESCWA).
ESCWA is a web user interface and server for modern administration, monitoring and control of Enterprise
Server. It offers improved usability that consolidates the different Enterprise Server user interfaces so that
native and managed regions, and security stores can be managed in one place. Features include:
•
•
•
•

•
•
•

Administering directory servers across multiple hosts.
Monitoring and control of Enterprise Server instances.
Configuring and administering a security store, defined in an LDAP-compatible security manager such
as Microsoft Active Directory or OpenLDAP.
Administering the Scale-Out features - enable you to specify logical groups of Enterprise Server
instances, and configure and run Performance Availability Clusters (PACs) and their related Scale-Out
Repositories (SORs).
Administering, monitoring and control of Enterprise Server for .NET regions and listeners.
The use of current web frameworks that have a greater focus on security.
(Included with 5.0 Patch Update 2 ) - support for Enterprise Server XA, MQ and PL/I configuration and
monitoring. This includes support for XA resources, configuring MQ, Listeners and Writers, PL/I, MFCS
console, Region Trace options, displaying the current ESMs on logon page and Local/loopback
connections warning changes.

COBOL Language Enhancements
Back to Top
The following enhancements have been made to the COBOL syntax:
•

ISO2002 conditional compilation - an additional mechanism for conditional compilation, the ISO2002
Conditional Compilation method, is now available. This has been implemented as part of the support for
Enterprise COBOL 6.2.
The following compiler directing statements are supported:
>>DEFINE
>>IF/>>ELSE/>>END-IF

•
•
•

>>EVALUATE/>>WHEN/>>WHEN OTHER/>>END-EVALUATE
The JSON PARSE statement enables you to convert JSON text into COBOL data formats. This has
been implemented as part of the support for Enterprise COBOL 6.2.
Async and await syntax (.NET COBOL only) - support is available for asynchronous programming
in .NET COBOL using the async and await syntax.
INSPECT statement - the performance of INSPECT... CONVERTING has been improved, particularly
for cases where source-alphabet is long.

What's New

|7

•

Support has been added for the portable syntax for SET - set[string].

Compiler Directives
Back to Top
The following Compiler directives are new in this release:
JVMTARGET

Specifies the JVM version number targeted by the class files generated in this
compilation unit.

ILNORMALIZENAMES Determines the program elements that are normalized when a program is
compiled to .NET or JVM COBOL. Normalization in this context results in
replacing all $ and - (hyphen) characters with _ (underscore) characters in the
name of the generated class file.

Consolidated Trace Facility (CTF)
Back to Top
This release provides the following enhancements:
•

•

Availability of CTF from the Eclipse interface - a new property tab, CTF, in the Eclipse launch
configuration dialog box helps to enable CTF tracing and specify a CTF configuration file. By default, the
trace files are then saved in a Logs subfolder within the project's folder.
Dynamic CTF - it is now possible to configure the CTF dynamically from outside the process being
traced. This feature is only currently available on Windows platforms.
Using a new command line utility - cblctd - you can alter the tracing events of running applications
that already have CTF tracing enabled. You can alter trace levels, add or remove components to or from
the trace, and also configure the emitters in effect.
Additionally, there is also a new component that you can trace - mf.mfdbfh enables you to trace activity
of the Micro Focus Native Database File Handler.

Data File Tools
Back to Top
This release provides the following enhancements:
•
•
•
•
•

The Data File Editor now includes a Compare Files tool that enables you to compare the contents of
two data files side-by-side.
Structure files, and the layouts within them, can now be created within the Data File Editor; you no
longer need to use the Classic Data File Tools utility to manage your layouts.
When connecting to a VSAM dataset stored in an enterprise server region, you can store any
passwords required for access, for the duration of your current session.
You can view archived JES spool jobs that have been merged into one spool file using the merging
archived spool files process.
You can now quickly duplicate records in non-indexed files, using the Duplicate Record option.

Database Access
Back to Top
Enhancements are available in the following areas:
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OpenESQL ADO.NET Connection Editor Toolbar
•

•

A new "i" (information) button is available that provides all the details of any installed .NET provider.
Provides additional information mitigating resource definition and use within the ADO.NET Connection
editor
Static XA switch modules "Reconnect" - At the beginning of a global transaction, the XA switch will
attempt to reconnect temporarily broken connections to the database. If there is a temporary disconnect
to the database, there is no need to manually re-enable the XA switch to run transactions.

Database Connectors
Back to Top
You can now create an identity column in your database by using a new XFD directive IDENTITY_COLUMN. This must be specified on a numeric field.

Debugging
Back to Top
This release includes the following enhancements:
•

Animate - Eclipse now includes an additional menu option when debugging a COBOL program for
setting the speed and toggling Animate mode. When active, the program will automatically step through
each line of source code, updating the source code in the editor, the Debug Stack, Outline and
Variables Views. See Debugging Commands and Options in your product Help.

•

COBOL Visualizer - a new window in Visual Studio enables you to view and edit a data item during
debugging in either text or HEX forms. You invoke the window from the DataTip for the data item.

•

Conditional watchpoints - you can now specify conditions and hit counts for COBOL watchpoints. A
condition can be in the form of an expression or it can be a hit count (for the number of times memory
associated with a data item has been updated). The condition is evaluated each time the data item
being watched changes. If the condition evaluates to true, then program execution stops. This enables
more fine-tuning of the current watchpoint support and is useful when debugging large, complex
programs.

•

Dynamic core dumps - you can now invoke a core dump programmatically and continue execution of
your program. A new library routine, CBL_CREATE_CORE, enables you to produce a core file for the
current process or a process owned by the same user that owns the current process.

•

Improved visibility of the PERFORM stack - the PERFORM stack and PERFORM range names are
visible in system debuggers such as gdb in many cases on 32-bit Linux with Intel architecture and
Solaris with Intel architecture. This was already the case on AIX, 64-bit Solaris-Intel, and all other Linux
platforms (including 64-bit Linux-Intel).

•

Live Recording - a new environment variable, COB_LIVE_RECORD_SIZE, is now available to aid
performance during the creation of a live recording file. Use it to specify the amount of memory (in MB)
that is to be used to store events that are to be written to the live recording file. When the limit is
reached, the buffer is cycled so that the oldest events are removed to make space for the most recent
events.

•

In order to include source line numbers in run-time error messages, which makes the diagnosis of
issues in your program easier, the COBOL compiler now produces .idy files by default when building
from the command line, unless the NOANIM directive is specified. You can safely remove .idy files
after compilation if you do not need them; they do not need to be distributed with your application unless
you want to debug your code. However, unless you specify the ANIM directive, generated executables
such as .dll and .gnt will not be debuggable, which is consistent with prior behavior.

What's New

|9

Note: Behavior has not changed if you are using an IDE or build scripts generated by an IDE.
•

•

•

Stackdump files (Linux Intel 64-bit, Solaris Intel 64-bit, and Linux/390 platforms only) - you can produce
a stack trace for applications in a production environment that encounter a Run-Time system error. Use
the stackdump_on_error and stackdump_filename tunables to configure the production of a stackdump
file when an error occurs, from which you can locate the exact line of failing code in your program.
A new configurable tool is now available that dumps to a file stack traces of all threads in process on
any Run-Time System error. [Linux Intel, Solaris Intel, zLinux only – requires ANIM on 32-bit Linux
Intel]. This is only supported for native COBOL.
Line number information is now being output for optimized builds (on Linux Intel 64-bit, Solaris Intel 64bit, PowerLinux, zLinux, and Solaris SPARC platforms only). This is only supported for native COBOL.
Because of what optimization does, the information is imperfect, but it remains highly indicative. This
gives the following advantages:
•
•
•

Enables the use of the stackdump utility (where available) for optimised builds.
Provides location information should a signal occur when running in a system debugger such as gdb.
Provides some limited ability to step through optimized code in system debuggers.

Eclipse Integration
Back to Top
This release includes enhancements in the following areas:
•

•

•

Supported Eclipse versions - this release supports Eclipse 4.7 (Oxygen) and 4.8 (Photon). The setup
file installs Eclipse 4.8.
Eclipse 4.6 (Neon) is no longer supported.
Java support - the 64-bit Java 8 is required to run the Eclipse IDE. The setup file installs Adopt
OpenJDK 8 (u202) with Hotspot. Java 8 (32 or 64-bit versions), and Java 11 (64-bit version only) are
supported for executing JVM COBOL code and for native COBOL and Java interoperability. For full
details on the supported Java versions, see Software Requirements in your product Help.
COBOL editor:
•

•

•

•

Automatic insertion of END statements - Eclipse now automatically inserts the end clause for IF,
EVALUATE, PERFORM, EXEC and TRY statements.
• Automatic insertion of closing symbols - by default, Eclipse now automatically adds closing quotes
and brackets where required.
• Search text positioned between specified columns - the Micro Focus Find/Replace dialog box now
includes options to search between specified columns in the code.
Directive sets - Compiler directives for your projects are now saved in language-specific .mfdirset
XML files stored within a .settings subfolder in the project's folder. You can create your own versions
of .mfdirset files and verify them against an XML schema that Micro Focus supplies.
Previously, all settings were stored in a single, proprietary IDE project file. Existing projects which
currently specify directives and other similar settings in the .cobolproj file will be upgraded to use the
new .mfdirset files when imported or loaded in Visual COBOL 5.0. If you are storing your source
code in a source control system, ensure that you add the .mfdirset files to source control as well.
Remote connections - support is available for automatic SSH tunnelling of Visual COBOL Development
Hub network traffic. You can route most Visual COBOL Development Hub network traffic using SSH
port forwarding. This makes developing on a remote UNIX host running a firewall easier to configure. In
addition, the network traffic is encrypted as it is being sent within an SSH tunnel. See To create a
connection to a remote UNIX host running behind a firewall in the product Help.
User Interface:
•
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The COBOL Explorer view uses an icon overlaid with P to indicate COBOL programs that will not
be built because they are preceded by another of the same name on the build path.

•

Improved settings UI - the COBOL, and the Run-time Configuration settings pages now use a
property grid that also shows the definitions of the settings.

Enterprise Server Security
Back to Top
This release includes the following enhancements:
•

•

•

Security - security features can now be employed when developers and administrators install new
COBOL services (web services and EJBs) into an enterprise server instance over the network. There
are a number of authentication and authorization options that can be enabled. See Deployment
Listeners and The .mfdeploy File in your product Help.
Vault Facility - a new security feature has been added that enables some Enterprise Server components
to keep certain sensitive information in a form of storage defined as a vault, accessible via a
configurable vault provider. The default vault provider stores data in encrypted format on disk.
OpenSSL 1.1.1 - the OpenSSL security provider has been updated to OpenSSL version 1.1.1.
This is the stable Long Term Support version of OpenSSL.
•

Added support for the ratified TLS protocol version 1.3. TLS 1.3 benefits include:
•

•

•

•

•

Much shorter initial connection negotiation sequence. This reduces the time taken to establish a
link before starting to transmit data.
• Using only the most secure ciphers and hash methods.
• TLS 1.3 will be negotiated in preference to the older TLS protocols.
• Added support for new Ciphers and Key Exchange groups in line with TLS 1.3 requirements.
• The default security level for previously configured endpoints has been moved from Security Level 0
to Security Level 1. This removes the ability to accidentally make use of known-weak elements such
as SSL3 and MD5. Similar changes to the default Security Level have recently happened to Java,
Chrome, Firefox, and other systems providing secure connections.
Fileshare Security - the Fileshare Secure TCP/IP transport provider now supports the trusted use of
X509 certificates bearing the name of the Fileshare service as the Common Name element of the
certificate.
In previous releases, a secure connection to a Fileshare server was made using a certificate that
represented the network location upon which the Fileshare service was located. This method is still
supported, but does not distinguish between the exact Fileshare server that is being connected to when
more than one service can exist on a single host system. With this change, individual Fileshare services
can identify themselves by using a unique certificate. While running on the same host and registered
with the same network endpoint.
Support for Active Directory user groups and group name mapping - the Enterprise Server External
Security Facility's MLDAP ESM Module can now use Active Directory user group objects for Enterprise
Server user groups. Also, the module can now map long group names to the 8-character-maximum
names required for mainframe emulation.
Selective auditing - administrators can audit only security activity of particular interest, reducing audit
overhead and the volume of events. The Enterprise Server External Security Facility's MLDAP ESM
Module can now enable ESF Audit events only for particular users, groups, and resources.
Improved interaction with LDAP client libraries resulting in fewer LDAP-related issues and easier
diagnostics - the Enterprise Server External Security Facility's MLDAP ESM Module has improved
interoperation with LDAP client libraries:
•
•
•

The client library vendor and version information is logged after the library is loaded
The module has better heuristics for loading the correct library supplied by the OS vendor, so the
"provider" configuration option can generally be omitted
For OpenLDAP, the module sets its proprietary "connect timeout" option

What's New
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•

SNI support (requires 5.0 Patch Update 1 or later) - support has been added in Patch Update 1 for the
Server Name Identification (SNI) extension to TLS. This helps to avoid connectivity issues related to a
growing number of Web services being hosted on SNI servers.

Micro Focus Unit Testing Framework
Back to Top
This release provides support for the following functionality:
•
•

Data-driven unit tests - a new type of test suited to testing data where values read from a source are
passed through the same tests.
Test output colorization - test output can now include basic colorization for supported terminal
emulations. This feature must be run from the command line.

Platform Support
Back to Top
Support is now available for the following additional or updated operating systems:
•
•
•

SUSE (Power) 11 SP3, 12
Red Hat (Power) 7.2, 7.3
Windows Server 2019

For a full list of supported platforms, check HTTPS://SUPPORTLINE.MICROFOCUS.COM/
PRODAVAIL.ASPX.

Product Documentation
Back to Top
The following is new in this release:
•

•

Online context help in Visual Studio - online context Help is now the default setting for Visual COBOL
and opens the documentation available on Micro Focus SupportLine.
Visual COBOL local help is still supported and can be installed manually, if required. See After Installing
in the product Help for details.
The Comparison of COBOL with Other Managed Languages document has been updated to reflect the
recent enhancements in the .NET and JVM COBOL support.

Visual Studio Integration
Back to Top
This release includes enhancements in the following areas:
COBOL editor:
•
•
•
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Code snippets - new snippets are available for $if and $region statements, and for specifying
*cblformat off which indicates the area of code that is unaffected by formatting.
Collapsible regions - outlining is now available for IF, EVALUATE and PERFORM statements.
Peek Definition context menu command - this invokes a pop-up window, embedded in the editor,
showing the data item definition. You can use the feature both while editing and while debugging.

•
•

•
•

IntelliSense suggestions - IntelliSense suggestions for the COPY statement now include directories to
add.
(Introduced in 5.0 Patch Update 1) Choosing a separator for qualified field names - you can configure
IntelliSense to either use OF or IN as a separator in qualified field names - e.g. A-COUNT OF AWORK-1 or A-COUNT IN A-WORK-1. You can specify this in Tools > Options > Text Editor > Micro
Focus COBOL > IntelliSense, and on the Completion Lists page.
Find All References - the Find All References output window for COBOL has been enhanced, so you
can now filter results, group results, order results and search results.
Quick actions - the editor now displays light bulbs for creating a missing section or a paragraph, for
adding and sorting $ILUSING statements, and for removing or commenting out dead code.

Visual Studio tool windows:
•
•

The Error List window now includes a column for the Sequence Number.
You can use Visual Studio's Find All References tool window to search for references in your COBOL
projects.

New settings in the project property pages:
•
•

The Debug project properties page for managed projects now includes settings for either generating a
portable symbol file (.PDB) or for embedding the portable symbol information directly in the assembly.
The Smart Linkage section in the properties of managed projects now offers two new settings for
enabling the ILSMARTTRIM and ILSMARTANNOTATE Compiler directives.

New project template categories:
•

The COBOL project templates are organized in a new set of categories that better represent the tasks
and workloads used in modern development. Some of the categories, such as Azure or .NET Core, only
show if you have installed the support for these features in Visual Studio. For more information, see To
install missing features from the IDE in your product Help.

What's New
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Significant Changes in Behavior or Usage
This section describes significant changes in behavior or usage. These changes could potentially affect the
behavior of existing applications or impact the way the tools are used.
Where present, the numbers that follow each issue are the Support Incident Numbers followed by the
Reported Problem Incident (RPI) number (in parentheses).
•
•
•
•
•
•
•
•
•
•
•
•

Common Communications Interface
Compiler
Data Tools
Documentation
Eclipse IDE
Enterprise Server
Enterprise Server Auditing
File Handling
Interface Mapping Toolkit
Micro Focus Directory Server
MFCRYPTLIB
Request Packet Interface API

Common Communications Interface
Back to the list
•
•

•

•

Certificate subject names are now correctly checked against the name the client is attempting to
connect to. Certificates registered to "localhost" should now work as expected.
The default Cipher Suites List now includes @SECLEVEL=0. This indicates that backwards
compatibility with old certificates such as MD5 is to be retained. As a result of this change, you need to
review your use of the Cipher Suites List and of any old certificates.
If using Micro Focus Common Client(MFCC) or Micro Focus Communications Server(MFCS) to connect
to a non-existent remote host, it was possible to create a connection to a server listening on the same
port on the local system. This is no longer possible and a bad address error is reported in the error logs.
By default, in this and previous releases an SSL/TLS CCI client can trust a server which resides on an
IP address that is not an intended connection target. You can now specify the ssl_only_verify_literally
option in your CCI.INI file to restrict the certificate check to improve security. See “CCITCP Security
Options in the CCI.INI File” in your product Help for more information. When connecting to a non-CCI
protocol server, all clients perform strict certificate checking as the new default behavior

Compiler
Back to the list
•

The Search order has been updated, to allow the Compiler to find Java.

Data Tools
Back to the list
•

Accessing a dataset through the Data File Editor now obtains a shared lock on Enterprise Server when
you open the file in shared mode.
3170479 (1115346)
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Documentation
Back to the list
•

The ANIM Compiler directive has changed its default when compiling from the command line on
Windows platforms. The default is now ANIM. (Compiling from the IDE still defaults to ANIM.)

•

The validation of server certificates for TLS (also known as SSL) connections has been corrected. This
is likely to cause connection failures in cases where previously connections were incorrectly allowed.
For example, if Fileshare is secured with TLS, client applications must be configured to use the
hostname of the Fileshare server as it appears in the server's certificate. If the Micro Focus Directory
Server is secured with TLS, then MFDS clients, such as the casstart command-line utility, will need to
connect to it using a hostname that appears in the certificate MFDS is using. (Note that a certificate can
contain multiple hostnames.) Consult your Certification Authority administrator for more information.
3192497 (1117068)

Eclipse IDE
Back to the list
•

•

•

•

•

•
•

In the Expressions view, there has been a change to the way that the number of characters displayed is
controlled. The Hex part now always displays the same number of characters as the raw data part (note
that Eclipse enforces the character limit, so the number entered by the user will include those used to
display the hex values). A maximum length entry of 0 is now correctly interpreted as "no limit".
3161694 (1114658)
Eclipse now colorizes files that it will not build because they are preceded by other files of the same
name on the build path. The icon of such files is overlaid by an I or P and Eclipse shows a tooltip with
an explanation. This is to clarify the difference between this scenario and build-action-ignored.
3161416 (1114607)
Micro Focus Find/Replace now provides a Column Scope group that enables you to limit searches
between columns. You can specify columns or alternatively you can search only in the main code area
for the file type open in the editor. By default, it searches in all columns.
3142899 (1112931)
Compiler directives are now stored in .mfdirset files which can be specified for particular languages, at
project/config/folder/file level.
2853665 (1104556)
By default, COBOL, COBOL JVM, and Mainframe COBOL Projects have the EXITPROGRAM"ANSI"
directive set in the Project Settings > COBOL Properties. This specifies that if the EXIT PROGRAM
statement is executed in a program that is not under the control of a calling program, it causes
execution of the program to continue with the next executable statement. See EXITPROGRAM in your
product Help for more information.
The COBOL JVM method breakpoint can now be toggled on the heading of the method.
The Eclipse IDE has an improved user interface for settings. The COBOL, IMS, and the Run-time
Configuration settings pages now use a property grid that also displays the definitions of the settings.
As part of these changes the Output path, Target type, and Bitism are now specified in the project's
Link properties, click Micro Focus > Build Configurations > Link.

Enterprise Server
Back to the list
•

A number of audit events now contain some additional information.
3140310 (1112666)
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•

•

•

•

Previously, the /x option of the CASRDTEX utility had been duplicated to drive XML output. This
prevented the export of transactions which was the original meaning of /x. To generate an XML export,
you must now specify the option /xm.
3180233 (1116108)
casfhsf could hang when processing HSF files that contain records from tasks that ran in different
months.
3177385 (1115884)
A new system transaction, CRCN, is now available to monitor the state of XA connections for each
resource manager (RM) entry defined in the system. CRCN is a replacement for the former XA
Reconnect facility that recycled SEPs on connection loss. The XA Reconnect facility was configured by
setting the ES_XA_RECONNECT environment variable. CRCN also uses this environment variable,
although its usage differs slightly. For more information see your product Help.
3174272 (1115727)
On Windows, any casout and cassub messages are displayed on cassub and casout API invocation if
the environment variable ES_CAS_API is not set to "ON".
3160400 (1114458)

Enterprise Server Auditing
Back to the list
•

Auditing on big-endian platforms now correctly interprets numeric audit data.

File Handling
Back to the list
•

RELFORMAT=MF|RM is now enabled for FOLDER and other filename tags.

•

3164916 (1114803)
The SORT-CONTROL special register is now supported during a SORT statement.

•

3159740 (1114389)
To direct the handling of relative files to a particular file handler (either MF COBOL or RM/COBOL), use
the RELFORMAT=MF or RELFORMAT=RM configuration options within the [REL-DEFAULT] tag of the
EXTFH.CFG file. (The default is RELFORMAT=MF.)
3157247 (1114149)

Interface Mapping Toolkit
Back to the list
•

If you try to deploy a stateful EJB SVI from the Visual Studio IDE after unchecking the “Reuse container
after application termination” check box (in the Deployment Characteristics tab of the Runtime
Environment Configuration dialog box), you receive a warning message informing you that the “Reuse
container after application termination” setting will be set to true for the deployment in order to prevent
the crash. In the Eclipse IDE, the unchecking of this option will just be ignored, and the option reselected. A warning to not uncheck the option for stateful EJB SVIs is also displayed on the prior page
(to the dialog box).
2663812 (1090987)

•

WSDL and JSON Schema files generated for bottom-up CICS Web services now include a
"maxLength" parameter for all string fields.
3175039 (1116241)
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Micro Focus Directory Server
Back to the list
•
•

The event codes for several MFDS audit points have changed.
On Windows, by default, the Enterprise Server Administration Web interface can only be contacted
using the loopback address (localhost or 127.0.0.1). You can enable remote access to the Web
interface by turning off the loopback mode. See "Using the Loopback Address" in your product Help for
more information.

MFCRYPTLIB
Back to the list
•

Passing an incorrect keyfile passphrase no longer results in receiving an RTS115 error in MFDS.
3181743 (1116186)

Request Packet Interface API
Back to the list
•

The default behaviour for TLS certificate Common Name (CN) matching has changed for release 5.0. It
now requires a strict match on the CN value or any Subject Alternate Name (SAN). For example,
127.0.0.1 and localhost are no longer implicitly equivalent, nor are hostname and its IP address or fullyqualified domain name (FQDN) variants. When starting a region from the Enterprise Server
Administration Web interface, a resolved IP address is used for the casstart -m parameter value. A
resolved IP address is also used even if a hostname is specified on a command line startup.
To change this behavior and use a resolved hostname value (as determined by the machine TCP
configuration, for example, hosts file entries.) set the environment variable MFDS_DNS_RESOLVE=Y.
To use an unresolved string literal hostname, for example, a value explicitly passed in via the casstart –
m command line parameter, set MFDS_DNS_RESOLVE=N.
3194613 (1117203)

Significant Changes in Behavior or Usage
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Known Issues
Refer to the Known Issues and Restrictions topic in the Product Information section of your product Help.
In addition, note the following:
•

In Visual COBOL 4.0 and 5.0, in an extremely small and limited set of cases, an issue could occur with
running older .NET executables and .dll, and older JVM .class files. This issue only occurred if:
1. The application performs an IS NUMERIC condition test on a variable declared with USAGE
NATIONAL.
2. The application has been created with Visual COBOL 3.0 or earlier, and executed in Visual COBOL
4.0 or 5.0.
In these rare cases, the IS NUMERIC test could provide the wrong answer. To resolve the issue, you
need to recompile any programs that uses this construct in Visual COBOL 5.0.
Program that do not use NATIONAL data, or those that have already been recompiled in Visual COBOL
5.0 are not affected.

•

If you have Visual Studio 2019 16.0 installed, the Create a new project dialog box does not list COBOL
in the Language field. You can find the COBOL project templates, by searching for either COBOL or
PL/I using the search field.
To resolve this problem and make the COBOL categories visible in the Language field, you need to
install Visual Studio 2019 version 16.1 or later.

•
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Known Issues

On Linux, the marketplace client in the supplied version of Eclipse will not work correctly if the product is
installed in a spacey directory. Micro Focus recommends that you avoid installing the product in a
spacey directory on Linux, if you want to install any additional plugins from the Eclipse marketplace.

Resolved Issues
The numbers that follow each issue are the Support Incident Numbers followed by the Reported Problem
Incident (RPI) number (in parentheses).
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

Adis
Character Animator
Cob/Cbllink/Cblnames (32-bit PC)
Codeset Support
Compiler
Data Tools
Database Connectors
Debugging
Dialog System
Documentation
Embedded HTML Pre-Processor
Enterprise Server
File Handling
IDE
Interface Mapping Toolkit
Licensing
Micro Focus Common Client
Micro Focus Directory Server
Micro Focus Server Administrator
OpenSSL
Run-Time System
Setup
SQL: COBSQL
SQL: DB2
SQL: OpenESQL
SQL Option for DB2
Web Service Client
XML Schema to COBOL generation
XML Support

Adis
Back to the list
•

ERASE EOL no longer stops Keisen attributes being inherited when enabled by x"AF" function 81.

•

3169584 (1115178)
ACCEPT LINE POSITION data-item, where data item has the JUST clause, now works as expected
when the ADISCF pre-clear option is selected.

•

3126794 (1111471)
BLANK SCREEN BACKGROUND-COLOR n, where n > 7, now sets the intensity so that the bright
version of the color is used to fill the screen.
2856949 (1103978)

Resolved Issues
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Character Animator
Back to the list
•

Animator no longer slows down when continuously pressing Step.

•

3175862 (1115750)
Animator can now successfully locate executables via the COBPATH environment variable when the
COBPATH value is longer than 1024 characters.

•

3160496 (1114416)
Breakpoints are saved (that is, an .aif file is created) when CBL_DEBUG_START is used and the
process terminates.
3143776 (1113225)

Cob/Cbllink/Cblnames (32-bit PC)
Back to the list
•

Creating an executable or shared object with the cob flags -U or -d no longer results in an assembler
error message.

Codeset Support
Back to the list
•

Conversions from ASCII to EBCDIC, with null data, no longer get corrupted.
3155499 (1114114)

Compiler
Back to the list
•

•

A GO TO statement that references a qualified data name, rather than a procedure name, is now
correctly rejected by the Compiler.
3191922 (1117013)
A DBCS data item with a VALUE clause specifying ALL NX literal is now correctly rejected by the
Compiler.

•

3191623 (1116974)
Large UNSTRING statements no longer produce the following error: "001-f internal error 49".

•

3189648 (1116838)
A SET 88-level TO TRUE statement when the associated field is national is now working as expected.

•

•
•

•

3185855 (1116554)
A valid data declaration with a RENAMES THRU clause referencing other level 66 items no longer
produces Compiler error "COBCH0239S First data name does not precede second".
3184128 (1116376)
Parsing programs that contain numerous errors no longer causes Eclipse to crash.
3183896 (1116502)
A WHEN OTHER clause directly following another WHEN clause in an EVALUATE statement is now
rejected by the compiler when an Enterprise Cobol dialect is specified. This emulates the mainframe
behavior.
3183810 (1116464)
An RM dialect now supports data names up to 128 bytes in size.
3182342 (1116261)
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•

Specifying an inline method invoke inappropriately (such as in a SUBTRACT statement) now receives a
Compiler error, as expected. Passing inappropriate operands BY REFERENCE is similarly rejected.

•

3180642 (1116128)
A program compiled with the prexml preprocessor and the directive 'NOQUAL' now compiles as
expected.

•

3179843 (1116304)
A REPLACE statement that caused the last token of a copyfile to be replaced with a longer token, and
thus caused the creation of an extra line, now works as expected.

•

•
•

3178437 (1115957)
A COBOL program compiled with a mainframe dialect should treat mainframe KSDS files correctly.
They are of variable length regardless of whether the "record varying" phrase is used in the FD.
Previously, this was not being honored and when program A was calling program B using external files,
you received an RTS 226 error message.
3176783 (1115839)
User-defined functions with LOCAL-STORAGE data now compile and execute as expected.
3176478 (1115792)
A DISPLAY statement as the last line of an ON EXCEPTION clause of another statement, with a
following NOT ON EXCEPTION clause for the containing statement, and compiled with the RM compiler
option, now compiles as expected without internal errors.

•

3175442 (1115876)
An INSPECT CONVERTING statement with hexadecimal literals and compiled with
CHARSET(EBCDIC) now executes as expected.

•

3174833 (1115673)
Constructions of type INSPECT CONVERTING ZERO to <variable-name> now produce correct object
code and execute as expected.

•

3174064 (1115580)
An SQL program with file declarations and a missing WORKING-STORAGE header now executes as
expected.

•

3169882 (1115216)
During compilation, if the LIST directive had been specified and a license error occurred, an RTS error
114 would result. This has been fixed.

•

3169377 (1115474)
During compilation, if the LIST directive had been specified and a licensing error occurred, you received
an RTS error 114.

•

3169377 (1115319)
A COPY REPLACING statement spanning multiple lines, with commas on the end of those lines, is now
processed as expected; that is, those commas are treated as meaningful characters rather than simply
separators.

•

3168125 (1115173)
PARAGRAPH and CYCLE are now correctly treated as context sensitive reserved words under an
Enterprise COBOL dialect, allowing them to also be defined as user data names.

•

3167488 (1115004)
COPY SUFFIXING and COPY PREFIXING syntax now compiles and works as expected for long DBCS
words.

•

3166159 (1114885)
The IMTK wizard can now process COBOL source that contains non-standard characters, such as an
ampersand.
3164533 (1115157)
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•

Syntax involving an EXEC keyword, within an EXEC SQL statement, is now processed as expected.

•

3162629 (1115879)
The INSPECT ... CONVERTING ... TO FUNCTION ... syntax is now working as expected.

•

3160325 (1114393)
Compilation with the CP preprocessor, of a source that has very long lines and unexpanded tab
characters at the end of those lines, now works as expected.

•

3160255 (1114436)
A DISPLAY of a group item containing a large table, in a program containing the 'CONSOLE IS CRT'
special-name clause now compiles successfully.

•

3157068 (1114326)
The performance of the following syntax has been significantly improved, especially where sourcealphabet is long: INSPECT CONVERTING source-alphabet TO target-alphabet

•

3157067 (1114137)
DISPLAY of a SCREEN SECTION sub-group no longer gives a COBRT153 error if there are other subgroups with OCCURS items with un-initialized indexes.

•

3154391 (1113915)
Printer files under an RM dialect are now emulated correctly.

•

3143299 (1113494)
DISPLAY UPON ARGUMENT-NUMBER now behaves as expected under CHARSET"EBCDIC".

•

3116649 (1110478)
When evaluating a method invoked inline as in the example below, the method was executed for each
WHEN statement which could result in undesired side effects. Example:
evaluate object::"method"(1)
when 0
when 1
when 2
Now, the result is stored in a temporary item and used in any comparisons with the expressions in the
WHEN clause.

•

An INITIALIZE statement acting on a subscripted group, which itself contains a subsidiary subscripted
group, sometimes failed to initialize all elements of that subsidiary group, in the case when the subscript
of the original group was expressed as a literal. For example:
01 g1.
03 g2 occurs 3.
05 g3 occurs 3.
07 n1 binary-long.
07 x1 pic xxxx value "ABCD".
initialize g2(1)
display g2(1)
In this case, only the first occurrence of x1 was initialized to spaces. This is now fixed.
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•

3186540 (1116571)
Normally, binlit(boolean) should be switched automatically in the presence of PIC 1 data. However, this
was not happening for programs compiled with the ILSOURCE Compiler directive.

•

3184579 (1116412)
Moving from a floating point item to a comp-5 item no longer results in the loss of the most significant
digits.

•

3177978 (1115909)
With the directive OUTDD set, a DISPLAY statement referencing an item of zero length could cause an
index-out-of-range exception.

| Resolved Issues

•

•

•

•

•
•

•
•
•
•
•

3176176 (1116853)
An EXIT METHOD in a performed procedure inside a method could be ignored, with the result that
control flow returned from the PERFORM, and continued to the next statement. This is now fixed.
3176170 (1115770)
If a method included an anonymous method (i.e a code block delimited by delegate/end-delegate), and
if the method included local data of generic COBOL type (i.e. a pic x or group data, but not object
references or primitive numeric data items), this could result in producing corrupt code.
3174920 (1115692)
A RAISE statement (or a GO TO) at the end of the main method could cause a system error. This only
occurred when the main method had a native .NET parameter (such as a string object) passed by
reference.
3166049 (1114881)
When generating managed code, incorrect code was generated when a string property was the target
of a STRING statement. This could also happen when a STRING statement with an INTO phrase
referencing a PIC X item used string objects in one or more other operands.
3160597 (1114443)
The syntax SET pointer-1 TO pointer-2 now behaves as expected when AMODE"31" is in effect.
3159008 (1114361)
When a COMPUTE statement contains no SIZE ERROR clause, and when execution of that
COMPUTE statement would cause a size error condition, and when the directive HOSTARITHMETIC is
on, then the result stored in the target field is now working as expected.
3155736 (1114028)
A warning message is now produced if a namespace specified by the ILUSING directive is not found.
Use of THREAD-LOCAL-STORAGE and THREAD-LOCAL is only permitted in procedural COBOL
programs when compiling for managed code.
Documentation for the ANIM directive has been modified to indicate that NOANIM is still the default for
managed compilation on Windows.
You now receive an error message after background parsing when you specify an invalid directive using
the $SET statement. Any error messages with start location will now contain the correct offset.
Compiling a very large COBOL program with many GO TO statements to JVM no longer results in a
verification error on program load.

•

3188208 (1116743)
A CALL statement USING by reference the address of a non-01-level linkage item no longer causes the
containing linkage record to have a new address on return from the call.

•

3179701 (1116403)
Very large programs including XML PARSE or XML GENERATE statements no longer produce system
errors during compilation to JVM.

•

3179669 (1116054)
An INSPECT phrase without BEFORE/AFTER, followed by another with either BEFORE or AFTER, no
longer leads to incorrect results.

•

3172678 (1115458)
With the ODOSLIDE directive on, bad code is no longer sometimes generated for JVM, and you no
longer receive a verification error at program load.

•

3167786 (1115063)
Very large programs with highly overlapping perform ranges could generate bad class files, causing
verification errors when attempting to load. This has been fixed.
3166644 (1115146)
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•

•

This release provides a new utility, GetBias. It enables mapping of line numbers output from large
COBOL programs compiled to JVM onto real sequential line numbers. If the length of a COBOL
program exceeds 65536 lines, the compile will adjust the line numbers output to the JVM class file, but
subtracting a 'bias' value from the actual value. In cases where such a program throws an exception,
and the line number is therefore displayed as part of the stack trace, the GetBias utility enables you to
discover the true sequential line number.
3161708 (1114641)
When compiling for managed code, if a variable length group is passed as a parameter to another
program, the generated code was attempting to evaluate the current length of that variable length group.
In native code, this evaluation only happens in the case where the OCCURS DEPENDING ON item is
not itself part of the variable length group. This difference meant that in some cases a null pointer
exception could occur in managed code, whereas native code executed without error. Managed code
behavior has now been modified to be compatible with that of native code.
3154134 (1113891)

•

•

•

When debugging an SQL program, stepping an EXEC SQL OPEN statement could cause the final line
of the program to be incorrectly highlighted.
3191710 (1117009)
In native generated code, on all platforms except Intel x86 32-bit, a COMPUTE statement with fixedpoint operands and a floating-point (comp-1 or comp-2) target could give the wrong result if a fixed-point
operand was used twice in the expression. This bug has been fixed.
3188676 (1116745)
On the IBM mainframe, when code is compiled with NOPFD, and when an unsigned COMP-3 item
containing an invalid sign nibble (such as 0xD) is the source item in a MOVE to another COMP-3 item,
the sign nibble is fixed up to the correct value: 0xC for a signed COMP-3 target, and 0xF for an
unsigned COMP-3 target. Micro Focus COBOL now emulates this behavior when code is compiled with
SIGNFIXUP.

•

3173432 (1115972)
An issue where the COBIDY directive was handled inconsistently between the Compiler and NCG has
been fixed.

•

3163263 (1115112)
A generate time error where the following message was produced has been fixed: FATAL ERROR
in ../coil/cio_jopt.c:deleting_bc() line 41; expected compare .

•

•
•

3160837 (1114435)
For 32-bit generated code on Intel x86 platforms only: A bug has been fixed where a DISPLAY
statement in generated code, compiled with LINKCHECK, would not give an RTS 203 error when using
an unassigned linkage item.
3159106 (1114292)
In generated code, a move of the form "MOVE NATIONAL-ITEM TO NATIONAL-ITEM-JUSTIFIED"
produced incorrect results when the target item was longer than the source.
CHAIN <literal> ON EXCEPTION and CHAIN <literal> ON OVERFLOW did not work correctly when the
overflow case occurred in native generated code on all platforms, with the exception of Intel x86 32-bit.
This has been fixed.

Enterprise Server
Back to the list
•

There is no longer an issue with the order of file retrieval for the list of console logs affecting the
calculated maximum log number.
3192214 (1117023)
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•

LRECL fields are now displayed correctly in Data File Tools when accessing Enterprise Server hosted
data files.

•

3186524 (1116586)
An issue with stopping printer terminals has now been resolved.

•

3185553 (1116498)
MQ Security is now used when using DSNRLI.

•

•
•

3183523 (1116641)
In Data Files Tools, the performance of opening a PO dataset that is hosted within Enterprise Server
has been improved.
3178780 (1116293)
An issue that caused CTG requests using SNT users to be rejected has now been resolved.
3178729 (1115967)
An issue with IBM PCOM was resulting in different colors in BMS in RUMBA and PCOMM. To work
around this, use the new environment variable ES_3270_REMOVE_NULL_COLOR_ATTRIB. Set
ES_3270_REMOVE_NULL_COLOR_ATTRIB to y or Y to prevent the color attribute set to null from
being sent in a 3270 flow.

•

3176924 (1115831)
The MQ XA switch modules now supports the BATCHONLY option.

•

3173781 (1115552)
Previously, xwbauth user exit was not invoked if URIMAP path was greater than 64 characters.

•

•

3173349 (1115514)
When a region was configured to use Extended User Storage, the associated memory was not
registered with MFPM. This resulted in issues when using GETMAIN SHARED from a program
compiled with the AMODE directive.
3173307 (1115549)
casout will no longer crash when using the /v option and there are more than 256 initiators/batch
printers/mprs.
Information for approximately 1300 processes can now be returned. If more than that exist, then casout
will return as much as it can and set return-code to 4.
This may be caused by schedulers using the entry point 'casout_getSEPS'. This can be called after
using the casout API with the /v option. The signature for this entry point is:
entry 'casout_getSEPS' using lk-casout-area.
lk-casout-area is defined in casbout.cpy but can only hold information for up to 256 processes. If there
are more than 256 processes then a call to this entry point will return truncated data (that is, 256
instances) and set return-code to 4.
Since casout /v can now return data for more than 256 processes, a new optional parameter, which is a
pointer, has been added to casout_getSEPS:
entry 'casout_getSEPS' using lk-casout-area lk-casout-user-area-ptr.
If there is data for more than 256 processes, then this pointer will be set to the address of the entire
block of data.

•

•

3171604 (1115376)
Transaction routing requests from the same terminal to an ISC connected region involving a DPL
request to an APPC connected SYSTEM now execute successfully.
3170073 (1115270)
Transactions with a timeout that was running over midnight were timing out prematurely at midnight.
3169194 (1115144)
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•

Event manager exits that are enabled for SEP termination events are now invoked when a SEP, Initiator,
MPR or a printer is stopped cleanly (from ESMAC and casout) and not just when they are killed.

•

3168159 (1115051)
The cursor position is now correctly identified when using floating maps - a map on top of another map.

•

3166543 (1114958)
If created from a previous run, cas_ipcs.lst and cas_ps.lst will now be deleted at the next region startup.

•

•

3165807 (1114872)
In a heavily loaded Enterprise Server cluster, it was possible for jobs to be dispatched to a printer
process instead of to a batch initiator. This would result in the job's lock being permanently held and
prevent further submission of jobs of that name.
3162806 (1116082)
When Enterprise Server activates an LU62 connection to the mainframe or to another APPC linked
system, you can now leave the modename to SPACE. This indicates that the remote side of the APPC
connection should use an elected default modename.

•

3162296 (1114713)
The position of a cursor on a map which size is different from that of the terminal size was incorrect.
This has been fixed.

•

3158745 (1114273)
In an ESM secure region, when the userid field in a terminal definition was populated, there were issues
at region startup or when trying to install the TERMINAL resource.

•

3158468 (1115137)
The environment variable ES_DDBG_PORT_RANGE now supports ports that include less than five
characters.

•

3158205 (1114237)
With ES_XA_NB_RETRIES=-1 specified, Enterprise Server would leak SHM if the connection to the XA
RM was lost.

•

3158011 (1114246)
An issue where a region would take too long to start up and eventually fail to start has been resolved.

•

3153774 (1113875)
Return codes from file operations on the spool files are now displayed correctly when there is an error.

•

•

•

•
•

3153516 (1113882)
When Data File Editor accesses files managed by an enterprise server region, users now need
UPDATE permissions in order to access the file exclusively.
3152798 (1113831)
When connecting a TN3270 to an Enterprise Server instance, if the connection was lost, the printer
could not be reconnected. Now you can navigate back to ESMAC, then Clients, and stop the printer in
order to reconnect it after a loss of the connection.
3142113 (1112847)
Formatting a trace that was captured during the period when the clocks went back an hour will now
format the entire trace. Previously, the formatter would exit at the point when the clocks changed.
2876312 (1106883)
An issue with exporting PCT resources has been resolved.
Enterprise Server, LDAP-based security: The use of Active Directory groups, or other group classes
that specify membership using LDAP Distinguished Names, now works correctly when the "user ID
attribute" configuration option is also used.
3187284 (1116696)
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•

•

•

•

•

•

•

•

•

•

The Enterprise Server External Security Facility (ESF) now strips leading and trailing whitespace from
the user ID and other relevant fields in Verify (user authentication) requests.
3185569 (1116548)
For Enterprise Server LDAP-based security, recent fixes to group processing exposed an issue when
multiple LDAP repositories are used and all-groups mode is enabled. This could cause some or all of a
user's group memberships to be disregarded, leading to incorrect denial of access to resources. The
problem has been corrected.
3182724 (1116269)
Enterprise Server's MLDAP ESM Module now supports setting LDAP passwords using salted
SHA2-512 hashes. Otherwise known as the SSHA512 LDAP password type.
3178540 (1116077)
In Enterprise Server with LDAP-based security where a security configuration uses two or more LDAPbased Security Managers, and use-all-groups mode and group federation are enabled, in some cases
group membership was not processed correctly. Messages about "configured number of groups
exceeded" could be logged. This issue has been resolved.
3178071 (1115917)
With certain Enterprise Server security configurations, the Data File Editor could display a "signon
failed" error when attempting to edit a dataset. This has now been fixed.
3177366 (1116022)
The cache feature of the Enterprise Server External Security Facility now ignores some metadata when
comparing requests with cache entries. This is configurable. By default, the subsystem (CICS, JES,
etc.) and facility (terminal name, if any) are ignored. No ESM Modules supplied with the product use
that information in making security decisions. This significantly improves the cache hit rate and system
performance in some environments. See "Enabling and Configuring Caching" in the product
documentation for more information.
3172719 (1115513)
When using LDAP-based security for Enterprise Server with an OpenLDAP-based provider (client)
library, the "connect timeout" setting now works correctly.
3172554 (1115522)
When using Enterprise Server with LDAP-based security, it is now possible to specify an LDAP attribute
for user-group objects which specifies an alternative name for the group using the group short name
attribute. See "MLDAP ESM Module Custom Configuration Information" in your product Help for more
information.
3171437 (1115364)
Enterprise Server LDAP-based external security no longer experiences a rare failure ("error code 7")
when verifying a user with advanced group processing options enabled.
3168197 (1115048)
LDAP-based security for Enterprise Server could produce MD5 password hashes (using the
"mode=bind" and "password type=MD5" configuration option; note this is rarely used) which did not use
the canonical Base64 encoding. Some LDAP servers did not recognize these password verifiers,
resulting in sign-on failures after users changed their passwords. This has been fixed.

•

3162441 (1114843)
In Enterprise Server, the MLDAP ESM Module now supports the short-to-long username mapping
option of the External Security Facility (ESF).

•

3160464 (1114394)
Enterprise Server now includes LDIF (LDAP Data Interchange Format) files suitable for configuring
LDAP-based security using the OpenLDAP server.
3147666 (1113475)
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•

•

•

•

Enterprise Server's optional LDAP-based security (External Security Facility with MLDAP ESM Module)
now supports the Microsoft "group" LDAP class, as used by Active Directory and AD/LDS. Consult the
online product Help or ask Micro Focus Customer Care for additional information.
3109881 (1110084)
On Linux and UNIX platforms, the MLDAP ESM module in Enterprise Server LDAP-based security, by
default searches for an appropriate LDAP provider (client shared object) in the default locations used by
the OS vendor's preferred LDAP client package. It is also no longer necessary to specify the "provider"
option in a Security Manager configuration.
An issue which resulted in the DELETE and DETAILS button staying disabled in the casrdo45 page has
now been fixed.
3181230 (1116351)
Previously, when viewing cataloged datasets or Spool files in ESMAC, it was not possible to view any
lines beyond line 99,999. Now the limit for the START field in ESMAC has been increased to hold any
number up to 99,999,999.

•

3181032 (1116152)
An RTS error 153 occurred when more than 6400 PCT entries were displayed in ESMAC. This has
been fixed.

•

3167388 (1115007)
With some specific LDAP configurations there were problems with accessing datasets from ESMAC
where the configuration should have allowed access. This has now been fixed.

•

3167364 (1114989)
The response time for catalog searches using 44 character strings in ESMAC has been improved.

•

3162969 (1114933)
Remove locks is now enabled if the user has authorization in ESMAC.

•

3157534 (1114372)
Deprecation of set-cookie meta tag in newer versions of some browsers such as Chrome or Microsoft
Edge caused issues with the cookies used by ESMAC. This has now been resolved.
3154175 (1113973)

•

•

The esfadmin command-line utility now allows command-line and option-file parameters of any length,
up to the maximum command-line length of 8192 bytes. All esfadmin parameters can appear in the
option file except -o (which specifies the name of the option file).
2881372 (1107519)
When using Enterprise Server with LDAP-based security, with two or more LDAP External Security
Managers, with the use-all-groups mode enabled, and with federation either enabled or in compatibility
mode (the default), it is no longer necessary to have a definition for each user in each LDAP ESM.
Specifically, once one LDAP ESM has identified the user, subsequent ESMs (those specified later in the
list of security managers) can specify additional groups for that user without having to define the user
again. For example, a security configuration specifies two LDAP security managers, LDAP-A and LDAPB. LDAP-A contains only user records. LDAP-B contains only group records and resource access rule
records. All-groups mode and federation are enabled. This configuration now works as expected.
2545079 (1081762)

•

xa_open in the switch module now returns the correct return-code.

•

3171133 (1115386)
The path of ESDB2XA switch module is not required in the environment variable LD_LIBRARY_PATH
when the application is compiled with XAID option and the dynamic switch module is used.
3164301 (1114734)

28

| Resolved Issues

•

Within the DB2 LUW switch module, issues associated with ESLOGGING xa_open string parameter
have been addressed, and better handling of impersonated userid when using USERP has been
provided.
3156639 (1114209)

Data Tools
Back to the list
•

•

The cursor is now visible in the free-text editing pane when the pane has focus whether it is in Shared
or Exclusive mode. The cursor position will start counting from column 1, rather than column 0 as well.
3154869 (1113954)
On systems with a Japanese Locale, the Data File Tools utility no longer includes the phrase "Technical
Preview" in its title.

Database Connectors
Back to the list
•

The compiler recognizes a new XFD directive that names an identity column. A Database Connectors
interface is free to use this information to optimize access to a particular row of a table. Instructions for
use:
The directive can be used on a numeric field, and has the following format: XFD IDENTITY-COLUMN.
If the directive is used on a non-numeric field, a warning will be displayed and the directive ignored.
If the directive is used on more than one field of a file, all but the first will be ignored, and a warning
issued.
This directive should only be used once per file, though no warning will display if you specify it multiple
times. Behavior in this case is undefined.
The directive should not be used on a KEY field, though no warning or error will be issued if you do this.
3184559 (1116426)

Debugging
Back to the list
•

The COBOL debugger could fail to determine the correct line to highlight in certain situations such as
'stop run', when run in the Docker environment on Windows.

•

It is now possible to debug a minidump from an Enterprise Server environment, in Visual Studio.
3142342 (1113099)

•

•
•

During animation on SUSE Linux Enterprise Server (SLES) 12, if the process being debugged was
waiting in a system-call and you attempted to exit the debug session, the session would have been
terminated rather that executing a 'stop run' in the debugger. This was due to a change in the operating
system between versions 11 and 12, which has now been corrected so that a 'stop run' is now correctly
executed.
While using the Character Animator to animate a program, if its stack overflows, the debug session no
longer stops - it now returns you to your source code and displays an error message.
Whilst debugging, examining variable values by hovering over the variable no longer causes an error.
3179385 (1116025)

Dialog System
Back to the list
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•

An issue which prevented character mode Dialog System from recognizing ctrl-J and other key
combinations has been resolved.
3189921 (1116908)

Documentation
Back to the list
•

The documentation for the compiler option -rc has been updated.

•

3184345 (1116419)
Result precision has been added to the following built-in functions topics in the LRM: INDEX,
MAXLENGTH, SEARCH, SEARCHR, VERIFY, VERIFYR.

•

•

3176098 (1116309)
The Database Connectors for MSSQL publication now includes a full set of configuration options, and
installation details.

•

3173722 (1115542)
The Software Requirement on UNIX topic in the docs and in the Release Notes now specifies that
SafeNet licensing requires that you have glibc-locale-32bit library installed on 64-bit machines.

•

3167672 (1115010)
The UNIX syntax example for the MAKESYN Compiler directive has been corrected in the
documentation.

•

3164533 (1115496)
Depending on the environment, you need to export (UNIX) or set (Windows) environment variables in a
script. See “To specify environment variables for an application” for more information.

•
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3183332 (1116336)
The product help now includes a clarification in the topic "To run a native COBOL application from a
network server". It states that you must remove any individual copies of run-time system modules (for
example, cblrtsm.dll) that might have been copied into your application’s working directory. This is to
avoid issues with running the application such as "245 no valid licenses found" as the run-time system
is not loading from the expected location, or where the copied run-time modules are from other versions
of the product versions. Removing such modules ensures that any run-time system modules are only
loaded from the Enterprise Server instance installed on the server.

3164533 (1116625)
The product help now lists some additional requirements when running .NET COBOL applications from
a network server. Your workstations must have the Microsoft .NET Framework version 4.5.2 or later and
the Microsoft Visual C++ 2017 Redistributable Runtime installed.

•

3161217 (1114487)
The documentation now includes the instruction that when deploying a subset of Run-time System files,
you must include run.cfg in a sub-directory named 'etc'.

•

3160902 (1114441)
The syntax example, listed in the documentation for the ILPARAMS Compiler directive, has been
corrected.

•

3154632 (634308)
When performing a sort that specifies more than one input file, you cannot specify one of those same
files as the output file unless it is the first input file specified.

•

3153333 (1113833)
Details of how to use ILBOABN0 have been added to the documentation.

•

3148996 (1113634)
The "Tutorial: Creating and Accessing WCF COBOL Services" in the product help has been updated.

| Resolved Issues

•

•
•
•
•

•
•
•
•
•
•
•

•

•
•

•

•

•
•
•

3125963 (1114011)
The documentation (in the COBOL Language Reference) has been updated to clarify the use of the
OPTIONAL keyword, and the use of (managed) optional parameters within the Procedure Division
Header.
2883545 (1107792)
The National Locale Support (NLS) Library Routines section of the documentation now contains all
available NLS routines.
The Significant Changes in Behavior section of the documentation now includes the default change for
FASTINIT. (This change occurred in version 3.0, as stated in the release notes on release.)
The documentation has been improved for the CBL_LOCATE_FILE library routine concerning the use of
space- and null-terminated strings.
The Rebuild syntax differs between UNIX and Windows platforms. For any of the Rebuild options, UNIX
platforms use a hyphen (-) prefix before the letter, and Windows platforms use a forward-slash (/) before
the letter.
The recommended method of high availability for VSAM files in Enterprise Server is to use standalone
Fileshare. The documentation has been changed to reflect this.
The documentation has been updated to reflect that 'DEFAULT' is a reserved word when running under
an ENTCOBOL dialect.
In the documentation, the code example given in the 'Thread-specific Data Handling Routines' topic
now compiles cleanly.
The called program search order, as documented in the 'Backward Compatibility' section of the
documentation, has been corrected for Windows platforms.
The parameter definition for OOCTRL"+/-W" has been clarified in the documentation.
The documentation now contains a topic - Using a File Handler in JVM COBOL - detailing how to
manually configure the File Handler that a JVM COBOL project uses.
A link to the IBM documentation added to the 'DSNRLI Functions used for RRSAF' topic - this is to
enable you to locate full details on required parameters, and to give examples of its use.
3184952 (1116524)
The documentation now states that the section heading when adding environment variables through the
Enterprise Server UI is case sensitive.
3177135 (1115979)
The documentation explaining the scope for the HOST-NUMCOMPARE directive has been simplified.
3156368 (1114075)
The "To specify the location of application files" topic has been updated to clarify the location of IMS
copybooks.
3111136 (1109993)
Documentation for all Java API classes is now provided in HTML format and contained in an archive file
located by default in the %ProgramFiles(x86)%\Micro Focus\<product name>\javaee-ccl\docs directory.
See the Java API Classes topic in your product documentation for details.
3109273 (1109725)
Documentation for all Java API classes is now provided in HTML format and contained in an archive file
located by default in the %ProgramFiles(x86)%\Micro Focus\<product name>\javaee-ccl\docs directory.
See the Java API Classes topic in your product documentation for details.
3109271 (1109724)
The sample code listed in the CBL_DIR_SCAN_READ documentation has been formatted to enable
you to copy and paste the code, ready for compilation.
The sample in the documentation on 'Using FHRedir and an allocation override rule' has been corrected
to show the spool filenames in their correct case (upper case).
The documentation now includes a definition for the system abend code S913 (which is "Security
Violation - the user is not permitted to access the resource").
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Embedded HTML Pre-Processor
Back to the list
•

An issue that caused the embedded HTML preprocessor to display incorrect banner information has
been corrected.
3160255 (1114437)

File Handling
Back to the list
•

Under certain circumstances, opening a sequential file in the editor could result in the editor throwing an
exception during close-down. This has now been resolved.
3145420 (1113132)

•

•

Warning messages when checking disk space for Fileshare advanced logging are now only displayed
when necessary. Previously, a disk space warning was given even if sufficient space was available.
3174510 (1116078)
A Fileshare server shutdown no longer leaves files opened or users remaining logged on.
2837526 (1108076)

•

CFLE updating large record no longer results in an RTS252 error with the HA-VSAM configuration.

•

3167973 (1115057)
You will no longer receive an RTS114 error when a failing primary node is restarted and attempts to rejoin the HA group (as a standby node), as long as it closed all files successfully before the failure.
3159872 (1114360)

•

Rollback recovery will no longer hang when processing a bad log entry during a scan of the transaction
log file.
3168055 (1115049)

•

A new MFJSORT option allows input LSEQ files to be treated as FB through setting the environment
variable MFJSLSEQFB=ON.

•

3190089 (1116876)
SORT operations no longer compare field data that is outside of the current record length.

•

3187044 (1116633)
MFJSORT now ignores the RECORD TYPE value if the SORTIN dataset is non-VSAM.

•

3163293 (1114669)
During a SORT, the SUM statement now correctly handles 8-bytes BI fields.

•

•
•

•

3161349 (1114540)
An internal SORT program no longer returns a COBRT252 error for cataloged files when being
compiled with AMODE"31" and dialect"entcobol".
3161100 (1114586)
SORT no longer produces an RTS114 error when both outfil and sortout datasets are not defined.
3154290 (1113901)
MFJSORT now correctly honors MFJ_INPUTDS_ERROR=N on missing physical concatenated
datasets.
3153313 (1113826)
MFJSORT OUTREC now applies the correct length for EDIT patterns.
3145526 (1113484)
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IDE
Back to the list
•

The ASP.NET code-behind files are now updated correctly when the web form is changed.

•

3183873 (1116358)
The Show Console Log menu item in Server Explorer now works correctly for servers in which the
'Configuration information' property is larger than 1024 characters.

•

3182582 (1116297)
An issue where a project build could fail due to a locked IDY file after debugging managed code that
contains partial classes has been fixed.

•

3180008 (1116114)
The on-demand code analysis now works correctly with SQL programs.

•

3179276 (1116015)
'Go To All' now correctly returns module names in programs which use a mainframe dialect.

•

3178541 (1115978)
The quick action "Extract the selected code to a new section" now creates a new section positioned
before any comments that belong to the following section.

•

3178510 (1115955)
Copybooks are now expanded correctly when debugging mainframe programs that are not part of a
project.

•
•

3173323 (1115554)
The resource editor now correctly generates resource entries for image files that contain spaces.
3171165 (1115424)
There is a new Visual Studio setting in Tools > Options > Micro Focus > Projects, Restore error
messages on project load. When enabled, it helps to restore the contents of the Error List and the icon
overlays from the previous IDE session for that project.

•

3169606 (1115197)
When selecting a copybook from the IntelliSense list, the format of the copybook name to insert in the
code is determined by the COBOL dialect of the source file.

•

3169303 (1115196)
The "Preview Changes - Determine Directives" dialog box no longer lists the "Set NOSQL" option when
the option has not previously been set.

•

3168960 (1115481)
Group items are now always colored red when referenced by name.

•

3166449 (1114920)
A UNC path can now be specified as the output path for a COBOL project.

•

•

•

3166250 (1114929)
Information in columns 1-6 of a copybook which is included in a program using COPY... REPLACING is
now displayed when the copybook is expanded. When using the 'Find' command, the copybook must be
expanded in order for the content to be found.
3163453 (1114687)
A new Visual Studio setting enables you to specify whether the current file and its dependent copybooks
are saved when compiling a standalone program. You configure this in Tools > Options > Micro Focus >
Standalone Editing and on the General tab - check "Save dependent copybooks".
3162731 (1114627)
Level 88 data items that have been referenced are now colored correctly in the editor.
3162191 (1114602)
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•

An issue causing Visual Studio 2017 to freeze when opening a solution has been resolved.

•

3161848 (1114537)
It is now possible to use the COBOL Visualizer window to modify alphanumeric data items while
debugging. The visualizer preserves null bytes which the standard visualizers do not support.

•

3156794 (1114109)
The QuickInfo logic has been improved to search for the best matching item when the user is hovering
over an ambiguous "redefines" item.

•

3154020 (1113951)
The Net Express Project Import wizard in Visual Studio now successfully imports projects that contain
control characters in the project's properties.

•
•

3151911 (1113692)
Saving the settings in Visual Studio now updates the project's settings file.
3151311 (1113848)
When debugging COBOL programs, you can now use a COBOL Visualizer in addition to the standard
Visual Studio visualizers when querying data COBOL data.

•

3136410 (1112316)
The progress dialog displayed when creating or starting a temporary server now includes a Cancel
button.
The Command Line tab in the properties of a COBOL file now displays the correct information when
"Set explicitly no SQL" is enabled for the file.
When debugging Enterprise Server applications loaded in Visual Studio in Open Folder mode, the IDE
no longer prompts for a program path.
Opening COBOL files that are not present in a project could crash Visual Studio (versions 15.8 and
newer).
IntelliSense in .xaml files is now supported for COBOL WPF applications.
Any changes to the settings in Tools > Options > Micro Focus > Enterprise Server are now saved
correctly.
The ASP.Net Web Application project template is only supported with versions of the .NET Framework
4.0 and later. With versions of the .NET Framework 2.0 to 3.5 SP1, you can only use the Empty
ASP.Net Web Application project template.
In Visual Studio 2017, attempting to debug managed code with expanded copybook view disabled
would cause the debugger to crash.
Expanding a debugger data tip while debugging .NET COBOL code in Visual Studio 15.8 or newer
could crash the IDE.
Viewing the Micro Focus Code Analysis properties for a project no longer causes the project file
contents to change.
All elements in a group item can now be displayed in the Watch or Autos windows when debugging.

•

Multi-dimensional arrays are now displayed correctly in the Expressions view.

•

3188114 (1116718)
We have resolved an issue where sources using $set P(cobsql) _and_ a directives file were not
correctly background parsed

•

3187247 (1116715)
The Show Console Log menu item in Server Explorer now works correctly for servers that have a
'Configuration information' property larger than 1024 characters.

•

3186091 (1116545)
References to .dir files that are located on a separate drive from that containing the project now
resolves the correct drive.

•
•
•
•
•
•
•

•
•
•

3185960 (1116529)
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•

•
•

You can now configure the Eclipse Content Assist to list proposal is alphabetical order. You can do this
from Window > Preferences > Micro Focus > Editor > Content Assist, and from the Proposal order
section.
3185289 (1116494)
Data items which contain XML or HTML data during debugging now display correctly in hover popups.
3182322 (1116238)
Text search errors caused by Eclipse's File Search functionality being multi-threaded and being
designed for local projects only have been fixed. File Search might now sometimes be slower but this is
unavoidable due to limitations in how third-party code can be modified.

•

3182272 (1116231)
Error messages were sometimes displayed on the wrong line when background parsing using the AWM
Remote Preprocessor. This has now been fixed.

•

3181225 (1116179)
You could experience an issue with starting Eclipse where Java Tooling would fail to initialize. This was
a result of a known issue with JNA and installing certain Windows updates.

•

3179471 (1116030)
SQL Include files were not always resolved when background parsing using the AWM Remote
Preprocessor. This has now been fixed.

•

3178446 (1115943)
COBOL Copybook project references in .cobolBuild files could be lost after importing the project in
Eclipse.

•

3177566 (1115903)
Users who have configured ESF passtoken generation can now access certain pages from the Server
Explorer view in Eclipse without having to reauthenticate. These include the spool and catalog pages of
regions, and the administration pages of directory servers.

•

3177270 (1115887)
It is now possible to compile individual programs within a COBOL JVM project, provided that the "Use
Dynamic Call" option is set within the project's properties.

•

3176560 (1115882)
Information about variables is now displayed correctly when debugging JVM COBOL using a Remote
Java Application debug configuration.

•

3173978 (1115582)
we now support ${ipaddress} and ${hostname} in the display preference, the latter is now used in the
default value

•

3170934 (1115477)
Smart Edit functionality has been updated to linewrap text, with new line characters pasted into the
editor correctly.

•
•

•

3168633 (1115534)
Visual COBOL for Eclipse now starts correctly, with no errors.
3165560 (1114888)
When debugging a remote application via a DevHub server it is now possible to use Remote File
System Directory entries in the Source Lookup search path. Previously, they were ignored unless a
remote project was selected in the launch configuration.
3165087 (1114802)
When debugging a remote application using source code held in local COBOL projects, program
sources were not found if the folders containing them were not included in the project's Copybook
search path. This is now fixed.
3165086 (1114804)
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•

•

•
•

•
•

•

•
•

It is now possible to cancel the launch of a "COBOL Wait for Application Attachment" (that uses a
specified host and port).
3164766 (1114784)
The Terminate and Remove menu item is now correctly handled for wait for attachment debug sessions
that have not yet attached.
3164766 (1115747)
A message to clarify the behavior of the environment script location field was added.
3164533 (1116627)
It is now possible to specify the default cobdebugremote port in Eclipse preferences. See "Preparing
Remote Projects for Debugging" in your product Help for more information.
3164533 (1114754)
The X Server font can now be set on the Debug preference page.
3164533 (1115214)
The "Server port, replaces ${port} in command" remote connection attribute has been added to enable
the configuration of the DevHub server port value when launching the server using the SSH daemon.
See "To launch a server on the remote host using a Secure Shell daemon process" in your product Help
for more information.
3164533 (1114753)
The COBOL Explorer filter facility is no longer disabled when the view is configured to exclude COBOL
Elements such as the COBOL Programs category.
3164096 (1114782)
Compilation of assembler files now respects the file specific settings when compiling individual files.
3162115 (1114600)
You can now right-click on a data item name anywhere in the working-storage or procedure division,
and click "Toggle Watchpoint". This adds a watchpoint to the breakpoints view in the same way as
selecting it from program outline.

•

3161772 (1114579)
There is now a Compile option in the context menu for folders in the COBOL Explorer and the PL/I
Explorer views.

•

3161499 (1114526)
Opening a project properties page in AWM without a project selected in the Application Explorer view
no longer throws a NullPointerException.

•

•

3160690 (1114434)
The "Inherit values from the build environment of the associated project" option in the project properties
(Micro Focus > Run-time Configuration > Environment Variables) was not being honoured. This has
been fixed.
3159999 (1114419)
Paths to dependent projects are now stored using relative paths if they can be determined.

•

3159506 (1114321)
The PL/I include dependency view did not always show the correct files if the macro pre-processor was
enabled.

•

3158083 (1114846)
A workspace with several projects that share an output directory no longer rebuilds projects infinitely in
a case when one of the projects compiles unsuccessfully.

•

3155067 (1113970)
Double-clicking on file search results now correctly jumps to the line containing the result.
3154115 (1113894)
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•

Linked resource entries in .cobolBuild are now stored using relative paths.

•

3153143 (1113836)
Micro Focus project types now correctly translate copy paths to the new pasted project location.

•

3152826 (1113856)
Copying and pasting remote projects has changed its behavior. A new "Copy Micro Focus Project"
dialog box is displayed asking you to confirm the remote details. Note: Micro Focus only support pasting
projects to the same remote connection as the project being copied.

•

3151350 (1113648)
When running the Remote Connection Diagnostics function, an unhandled exception was intermittently
logged. This has now been fixed.

•

3151350 (1114547)
This release includes initial support for formatting COBOL code. Access the formatting preferences from
Window > Preferences > Micro Focus > Editor > Formatter.

•

3146261 (1113549)
END-EXEC and CALL-CONVENTION are now correctly highlighted as keywords in COBOL programs.

•

3146260 (1113238)
Hit count and conditions are now supported for COBOL watchpoints.

•

3128708 (1113196)
The COBOL Run-Time System container has been updated to include a reference to mfle370.jar.

•

Copybooks and include files were not found during background parsing of remote COBOL programs if
they were located in a directory specified by the COBCPY environment variable before the DevHub
daemon was started. This has been fixed.
3165397 (1114851)

Interface Mapping Toolkit
Back to the list
•

For clients and services generated from WSDL, generated copybooks are no longer missing
declarations for complex WSDL fields with duplicate names.
3188506 (1116761)

•

A problem that caused invalid xsd:date types in a CICS Web Service WSBIND file generated from a
WSDL file has been fixed. xsd:date types are now generated as collapsed fields.
3184571 (1116456)

•

•

A limitation in the Interface Mapper that prevented the simultaneous editing of Field Properties for all
selected fields of a like field type has been fixed.
3164533 (1115571)
An issue that prevented manually created field mappings from correctly matching IMTK behavior has
been fixed.
3164533 (1115657)

Licensing
Back to the list
•

cesadmintool.sh now searches for " version" string in the Java version and ignores any additional output
that might appear.
3185425 (1116559)
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•

•

In Docker environments, the license administration program, MFLicenseAdmin, now copes with longerthan-usual license strings. These occur with longer pieces of customer information embedded in the
license.
3174371 (1115634)
There is no longer an entry in the Uninstall column for licenses installed on remote machines.
3131570 (1112101)

Micro Focus Common Client
Back to the list
•

Applications which use the Micro Focus Common Client (MFCC), such as the Interface Mapping Toolkit
(when deploying a COBOL web service or EJB to Enterprise Server), can now specify credentials when
binding to the Micro Focus Directory Server. This provides additional security. If credentials are not
configured, MFCC will use an anonymous bind, as it did in earlier product versions. Credentials are
specified using the mf-client.dat configuration file.

Micro Focus Directory Server
Back to the list
•

•

•

3190235 (1116886)
Additional Enterprise Server Administration Web UI server-side checks were added to guard against
non-editable field value changes for started Enterprise Server instances and active security
configurations.
3185626 (1116719)
Establishing a connection to a TLS-enabled MFDS process if non-default (non-DemoCA) certificates
were used now works as expected.

•

3174276 (1115675)
The MFDS journal data format has been enhanced to be platform and bitism independent.

•

3169565 (1115249)
Improved validation of data input to Enterprise Server Administration Web UI.

•

•

•
•

•
•
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The Enterprise Server Administration Web UI will only display user session details if the logged in user
is authorized.
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3163386 (1114693)
Adding or editing TCP listener-requested endpoint values using the Enterprise Server Administration
web UI so that a port clash may occur now gives a warning rather than being disallowed and treated as
a user input error.
If the Enterprise Server Administration Web UI is hosted in a Docker container, the displayed hyperlinks
to reach the Micro Focus Communications Process web pages can now be configured to use an
address which is valid outside the container.
URLs to SSL-enabled MFCS Control Channel addresses displayed in the Enterprise Server
Administration HTML UI now use an https prefix.
A new field, "Server CA Root Certificate", is available in the Communications Process Control Channel
page (id: c400). The value specified here is used unless the MFDS_server_CAROOT environment
variable was specified as it takes precedence. You must specify the server CA root certificate if the
Communications Process Control Channel is SSL/TLS-enabled and if communications with the MFDS
process are required such as to respond to keepalive and any other administration control requests.
Enterprise Server Administration Web UI would sometimes display the successful logon splash screen
instead of a logon error message.
The MFDS process could terminate when copying the definition of an Enterprise Server instance if it
contained a very long description text.

•
•

Trying to view or edit the properties of a Security Manager that is not in the Directory Server Security
Manager list now results in receiving an appropriate warning message instead of an HTTP 404 error.
MFDS now saves any changes made to the Communications Process immediately instead of at
shutdown.

Micro Focus Server Administrator
Back to the list
•

•

If Enterprise Server Administration was set to restricted access, some MQ listener configuration pages
would not be displayed.
3152874 (1113782)
The Enterprise Server Administration HTML UI no longer displays the IP address but only the host
name used by the Web administration server process.
3140974 (1112912)

OpenSSL
Back to the list
•

Visual COBOL, Enterprise Server, and Enterprise Developer now include an updated collection of
public Certification Authority root and intermediate certificates (CARootCerts.pem) derived from the
public collection maintained by Mozilla.org.

Run-Time System
Back to the list
•

Under certain circumstances, if a file was opened multiple times and an error occurred, then any
physical locks on the file could be lost.

•

3177819 (1116043)
In a threaded environment, when using critical-sections and simultaneously loading/unloading sharedobjects, a race condition would sometimes create a deadlock. This no longer occurs.

•

3177711 (1116154)
The use of the P(COBSQL) Compiler directive in a Visual Studio or Eclipse project no longer causes the
IDE to crash intermittently at termination.

•

3133807 (1112077)
The COBRT243 Class could not be loaded error message now contains the name of the class that
could not be found.

•
•

3104988 (1109420)
Calls to CBL_MEM_VALIDATE might not have given the full memory corruption details if the corruption
occurred in freed memory. This is now fixed.
When using the Character Animator, you can enter Ctrl+C to interrupt the running process you are
debugging. This would sometimes fail to stop the running process, but should now behave as expected.

•

When setting the out-length parameter of the CBL_STRING_CONVERT API to zero in order to get the
size of the buffer required for the conversion, the API no longer fails with a ArgumentNullException
when running on the .NET environment. Under JVM COBOL, this API no longer corrupts the output
buffer if the output length has been set to 0.

•

In managed COBOL, for a very small set of cases for exponentiation and DIVIDE ROUNDED,
performance was very poor. Also, for some of this set of cases, the result of DIVIDE ROUNDED could
round in the wrong direction. These issues have been fixed.
3185807 (1116589)

Resolved Issues

| 39

•

Within JVM COBOL, a MOVE operation from a COMP-2 item containing a negative value to an
unsigned COMP-5 item now gives the correct result.

•

3175547 (1115719)
Under JVM COBOL, RunUnit GetEnvironmentVariable() is now case insensitive on look-up of
environment names.

•

3161925 (1114545)
CALL "SYSTEM" in a JVM COBOL program that is executed from a run unit in Java no longer produces
a COBRT200 error if RunUnitStartupOptions.UseSingleThreadedRuntime is set.

•

3151448 (1114573)
JVM COBOL only. An issue has been resolved whereby some arithmetic expressions using a binary
item (COMP, COMP-5) that had the value -2147483648 ( - 2**31 ) could result in stack overflow.

Setup Issues
Back to the list
•

The Data File Tools AddPack can now be installed alongside Enterprise Server.

•

3158290 (1114230)
The installer error handling has been extended to cater for certain conditions.
3152023 (1113706)

SQL: COBSQL
Back to the list
•

COBSQL now handles "ELSE EXEC SQL" correctly when it is all on the same line in the source file.

•

3176046 (1115778)
The XAID option did not work properly for COBSQL when CHARSET(EBCDIC) was used.

•

3174070 (1115697)
A compilation error that was caused by the COBSQL preprocessor incorrectly handing sections
declared inside of a copybook has been fixed.

•

3164533 (1116863)
An unreadable copybook caused COBSQL to loop when stacked with the CP preprocessor. This has
been fixed.

•

3156374 (1114103)
An unreadable copybook caused COBSQL to loop when stacked with the CP preprocessor. This has
been fixed.

•

3156374 (637041)
An issue that caused a compilation error when COBSQL encountered inline comments in an EXEC
SQL statement has been fixed.

•

3123025 (1111044)
COBSQL messages have been updated to provide more information when failure is due to a missing list
file, and when the list file is missing due to use of the LTYPE=NONE directive.

•

2883514 (624749)
To prevent exceeding the COBSQL directive buffer size, the maximum directive buffer size has been
increased to a maximum of 8000 characters.

•

2852872 (1104084)
To prevent hanging or a compilation error, COBSQL has been updated to properly handle conditional
statements in the same line as EXEC SQL statements.
2804004 (1097225)
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•

•
•

An issue that sometimes caused SQL error text to display as truncated on the command line has been
fixed by increasing the maximum error length to 250 characters, and updating the logic used to
construct the message.
An issue that caused an error when a space was present between an END-EXEC statement and a
period has been fixed.
The COBSQL precompiler interprets the SOURCETABSTOP COBOL compiler directive as
SOURCETABSTOP(8) in all cases. This is due to Pro*COBOL honoring only SOURCETABSTOP(8),
and is a permanent restriction for COBSQL.

SQL: DB2
Back to the list
•

•

•

•

An optional 'FROM' keyword in SQL statements such as 'FETCH FROM <cursor-name>' used to cause
compiler errors.
3191635 (1116976)
There is no longer an issue with negative line numbers being generated in the .bnd file when the
COBOL source file has more than 32700 lines of code.
3188178 (1116814)
An issue with the DB2 preprocessor caused it to incorrectly classify PL/I variables greater than 4000
bytes as LONG VARCHAR when it should have classified PL/I variables less than 32767 bytes as
VARCHAR as it does for COBOL variables. This has been fixed.
3185976 (1116539)
DB2 XA switch source is now shipped for Linux ppc64le platforms.

•

3184287 (1116424)
The DB2 pre-compiler incorrectly generated a compile error when hyphen was used in SQL command
without a space between the hyphen and host variable name. This has now been fixed.

•

3180089 (1116102)
DB2 LUW now supports dashes in cursor names, so the DB2 pre-compiler no longer changes dashes
to underscores in cursor names.

•

3177271 (1115912)
The DB2 pre-compiler incorrectly passed COBOL variable names to PL/I programs when generating
code to handle EXEC SQL SET CURRENT PACKAGE PATH statements.

•

3175885 (1115744)
The DB2 and OpenESQL pre-compilers now qualify generated code that uses SQLSTATE to qualify
SQLSTATE similar to this one: SQLCA.SQLSTATE.

•

3173295 (1115512)
An issue that caused the DB2 preprocessor to incorrectly reject FILLER as a valid host variable name in
PL/I programs has been fixed.

•

3164600 (1114767)
An issue that occurred with user personalization on user names exactly eight characters long has been
resolved.

•

3156639 (1114163)
When a DBCS database is used with CHARSET(EBCDIC), the data of a char field following a varchar
field will no longer be corrupted.
3155499 (1114065)

SQL: OpenESQL
Back to the list
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•

JDBC now returns SQLCODE=+1 when the fetched value is NULL and NULL indicator is not used.

•

3191192 (1116953)
Decimal value is now inserted correctly into Oracle DB when DECDEL=COMMA is set.

•

3189836 (1116947)
An issue that caused performance degradation when using a STATIC cursor has been fixed.

•

3185894 (1116518)
The OpenESQL run-time now handles the compiler directive SQL(NOAUTOFETCH) correctly.

•

3177780 (1115994)
OpenESQL has been updated to provide cobrhcedsn64.so for 64-bit only platforms.

•

•

•

3174065 (1116801)
HCOSS now accepts FOR READ ONLY clauses in cursors before FETCH FIRST clauses. This is
undocumented behavior for DB2 z/OS but HCOSS now supports it to ensure mainframe compatibility.
3173586 (1115528)
An issue where WITH HOLD cursors could remain open after an IMS transaction had terminated for
SQL Server, ODBC and PostgreSQL XA resources has been fixed. SQL(NOCHECKDUPCURSOR) can
now be used to override duplicate cursor checking when SQL(DIALECT=MAINFRAME) is used.
3172382 (1115430)
A new SQL directive [NO]ALLOWSERVERSELECT supports server-specific SELECT statements that
are not recognized by OpenESQL as valid ESQL SELECT ... INTO statements. This behavior was the
default in Net Express.

•

3165092 (1114866)
An issue that caused the OpenESQL runtime to incorrectly handle binary parameter markers for PIC
X(n) VARYING host variables has been fixed.

•

3163759 (1114719)
The SQL Directives dialog box that appeared for .NET project types in the Visual Studio IDE
erroneously omitted the SQL(HSFTRACE) option for DBMAN=ADO. This has been fixed.

•

•

•

•

•

•

3162428 (1114593)
Data type information that was incorrectly mapped by the OpenESQL Assistant caused it to display
column information improperly when using an IBM DB2 ADO.NET provider connected to a DB2 z/OS
data source. This has been corrected.
3161285 (1114478)
An issue that occurred when the SQL BEHAVIOR compiler directive option was set to UNOPTIMIZED
caused the OpenESQL runtime to generate an RTS 114 error when the COBOL application exited. This
has been fixed.
3158065 (1114288)
Problems with SQL Server and PostgreSQL that surfaced when working with large binary columns have
been fixed.
3156215 (1114335)
An issue that caused the OpenESQL preprocessor to generate an incorrect error message when
SQL(DBRMLIB) was not set prior to specifying SQL(VERSION) has been fixed; the OpenESQL
preprocessor now generates the correct error message.
3155275 (1114004)
SQL FETCH ABSOLUTE CURSOR was not returning rows. A COMP position value is now supported in
the SQL FETCH ABSOLUTE/RELATIVE statement and it behaves as expected.
3153738 (1113903)
An issue that prevented HCOSS from correctly handing IS [NOT] DISTINCT predicates has been fixed.
3152630 (1113764)
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•

An issue that caused HCOSS to incorrectly apply QUALIFIERs to common table expression names has
been fixed.

•

3152008 (1113714)
The DSNRLI function SWITCH TO is now supported for Enterprise Server Mainframe Subsystem
applications using DB2, Microsoft SQL Server, and PostgreSQL.

•

3151779 (1113680)
An issue that caused HCOSS to incorrectly handle FETCH FIRST ROW ONLY when no literal row
count was present has been fixed.

•

3151398 (1113734)
An issue that caused the OpenESQL runtime to execute a core dump on exit when the
MEMORY_STRATEGY tunable was set has been fixed.

•

3142107 (1113077)
A program that contained zoned decimal host variables used in SQL statements and compiled using
charset(EBCDIC) and dialect(MF) sometimes caused a run-time error. This has been corrected.

SQL Option for DB2
Back to the list
•

•

The XDB pre-compiler incorrectly generated line and column number information used by the IDE to get
COBOL information about field on EXEC SQL INSERT statements.
3182574 (1116350)
The XDB pre-compiler incorrectly tried to generate interface logic in nested COBOL routines without
checking if a SQLCA copybook was defined. This resulted in an "Undefined ECM error" error message.
This has been fixed.
3168445 (1115099)

•

An issue caused by an uninitialized stack variable that resulted in a server violation has been fixed.
3168714 (1115237)

•

•

A number of XDB components have been enhanced to better implement bulk INSERT/UPDATE/
MERGE statements using both local XDB engines and XDB Link in dynamic and static mode to z/OS
DB2.
3175084 (1115695)
XDB Link has been updated to support the invocation of stored procedures that return multiple result
sets on z/OS DB2.
3168036 (1115315)

•

A memory leak in DRDA Continue Query Reply Message processing has been fixed.
3160580 (1114426)

•

•

•
•

An issue that prevented XDB Server configuration from allowing the full length of 16 characters in the
Global Security Location text box has been fixed.
3168821 (1115106)
An issue with SQL step processing related to CASE expression evaluation that caused the SQL
COALESCE scalar function to return the wrong result has been fixed.
3160595 (1114413)
Support has been added for the SOUNDEX() and DIFFERENCE() scalar functions.
3155733 (1114043)
An issue that caused a buffer overflow when processing a very large UPDATE WHERE CURRENT OF
in the XDB Link has been resolved.
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•

•

3151725 (1113807)
An problem with XUTLB (XDB emulation of DSNUTILB) erroneously reporting an invalid isolation level
has been resolved.
3134586 (1112183)
An issue with join optimization using differing lengths of DECIMAL data has been resolved.

•

3131870 (1111903)
An issue with a scalar query using a DATETIME value returning an error indicating that the value was
invalid has been resolved.

•

3129637 (1111872)
An issue with Query Descriptor mapping when performing XDB Server to Server connectivity has been
fixed.

•

3112564 (1110514)
An issue with an uninitialized stack space causing a thread abend in XDB SQLDA code page
processing has been fixed.
2990360 (1108708)

Web Service Client
Back to the list
•

When a generated Web service client executes, an additional optional user-supplied exit program, exithttp-resp-headers, is now called to provide access to any and all HTTP headers present in the response
message from the service.
3172598 (1115452)

XML Schema to COBOL generation
Back to the list
•

CBL2XML now handles the namespace of certain elements correctly.
3175256 (1115745)

XML Support
Back to the list
•

XML PARSE now handles "WITH ENCODING" clauses correctly.

•

3175231 (1115707)
Data within the CDATA tag is now processed by the managed XML syntax support run-time.

•

3166588 (1114954)
XML PARSE did not handle lengthy CONTENT-CHARACTERS correctly which caused the event to be
returned twice.

•

3162231 (1114582)
Literals positioned beyond column 72 in the editor are now being handled correctly and compile without
any issues.
3152550 (1114087)
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Other Issues Resolved in This Release
The numbers listed are the Support Incident Numbers followed by the Reported Problem Incident (RPI)
number (in parentheses).
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

3177187 (1115851)
3181887 (1116201)
3177661 (1116118)
3134735 (1112201)
3170148 (1115245)
3171080 (1115373)
3161109 (1114775)
3160774 (1114530)
3187599 (1116668)
3176925 (1115833)
2802311 (1097060)
3140337 (1112673)
3175137 (1115685)
3170946 (1115402)
3128586 (1111526)
3105876 (1109394)
2990180 (1108737)
2854004 (1103682)
2851622 (1103230)
2844942 (1102368)
2841043 (1102369)
2590883 (1085717)
3181941 (1116211)
3103315 (1109252)
2990950 (1108778)
2865338 (1105207)
2597474 (1088223)
3164898 (1114811)
3150507 (1113583)
3122080 (1110968)
3122020 (1110949)
3114654 (1110269)
2887726 (1108356)
2885799 (1108108)
2873642 (1106416)
2835954 (1101265)
2795293 (1096771)
2652488 (1090826)
2587952 (1086146)
3123593 (1111108)
2642528 (1090004)
2594601 (1086032)
3181445 (1116188)
3168020 (1115032)
3164533 (1115215)
3162064 (1114546)

•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

3158311 (1114231)
3158072 (1114399)
3141381 (1112770)
3164533 (1115570)
3193749 (1117140)
3158936 (1114346)
3156405 (1114097)
3152246 (1113749)
3157702 (1114217)
3157956 (1114290)
3127953 (1111577)
3159456 (1114310)
2867519 (1105516)
3191105 (1116958)
3174042 (1115569)
3176098 (1115962)
3172981 (1115501)
3127698 (1111446)
3189442 (1116934)
3188582 (1116744)
3178509 (1115958)
3160759 (1114427)
3150188 (1113906)
3177187 (1115851)
3181887 (1116201)
3177661 (1116118)
3134735 (1112201)
3170148 (1115245)
3171080 (1115373)
3161109 (1114775)
3160774 (1114530)
3187599 (1116668)
3176925 (1115833)
2802311 (1097060)
3140337 (1112673)
3175137 (1115685)
3170946 (1115402)
3128586 (1111526)
3105876 (1109394)
2990180 (1108737)
2854004 (1103682)
2851622 (1103230)
2844942 (1102368)
2841043 (1102369)
2590883 (1085717)
3181941 (1116211)

•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

2990950 (1108778)
2865338 (1105207)
2597474 (1088223)
3164898 (1114811)
3150507 (1113583)
3122080 (1110968)
3122020 (1110949)
3114654 (1110269)
2887726 (1108356)
2885799 (1108108)
2873642 (1106416)
2835954 (1101265)
2795293 (1096771)
2652488 (1090826)
2587952 (1086146)
3123593 (1111108)
2642528 (1090004)
2594601 (1086032)
3181445 (1116188)
3168020 (1115032)
3164533 (1115215)
3162064 (1114546)
3161964 (1114569)
3158311 (1114231)
3158072 (1114399)
3141381 (1112770)
3164533 (1115570)
3193749 (1117140)
3158936 (1114346)
3156405 (1114097)
3152246 (1113749)
3157702 (1114217)
3157956 (1114290)
3127953 (1111577)
3159456 (1114310)
2867519 (1105516)
3191105 (1116958)
3174042 (1115569)
3176098 (1115962)
3172981 (1115501)
3127698 (1111446)
3189442 (1116934)
3188582 (1116744)
3178509 (1115958)
3160759 (1114427)
3150188 (1113906)
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•
•
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3161964 (1114569)
3172126 (1115445)

| Other Issues Resolved in This Release

•

3103315 (1109252)

•

3187219 (1116640)

Unsupported Functionality
This section includes information about features or functionality that are no longer supported.
•

The HOSTSIGNS Compiler directive is no longer supported. Micro Focus recommends that you use the
following Compiler directives instead: SIGN-FIXUP, HOST-NUMMOVE, and HOST-NUMCOMPARE.
This is a change since version 3.0 of this product.
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Installation
Before Installing
Downloading the Product
You can download Visual COBOL from the Product Updates section of the Micro Focus SupportLine Web
site.

System Requirements
System Requirements for Visual COBOL for Visual Studio
Hardware Requirements
Visual COBOL has the following requirements in addition to the requirements of Microsoft Visual Studio.
See the Visual Studio documentation for details of the Microsoft requirements.
The maximum disk space requirements are, approximately:
Visual COBOL

Sentinel RMS License Manager

1.2Gb

75MB

•
•

This includes the space needed to cache information locally so that you can modify the installation
without the original source media.
The disk space requirements include the versions of JRE and .NET Framework supplied with the setup
file.

Operating Systems Supported
For a list of the supported operating systems, check the Product Availability section on the Micro Focus
SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.
Note:
•

You can produce both 32-bit and 64-bit applications with Visual COBOL installed on a 64-bit
operating system.

•

Support for development on Windows 8 and Windows Server 2012 has been discontinued. These
platforms are still supported for deployment. Windows 8.1 and Windows Server 2012 R2 are
supported.

•

Visual COBOL for Visual Studio is not supported on versions of Windows earlier than Windows 7.

Software Requirements
The setup file will check your machine for whether the prerequisite software is installed and will install any
missing prerequisites and the product components. A supported version of Microsoft's Visual Studio must
be installed in advance.
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Note:
•
•

Besides the software listed below, the setup file also installs the 64-bit AdoptOpenJDK's OpenJDK
8 (u202) with Hotspot.
This product includes OpenSSL version 1.1.1b.

Visual Studio IDE
You must have Microsoft's Visual Studio 2017 version 15.9.4 or a newer one or 2019 version 16.1 or a
newer one installed in advance. (Visual Studio 2019 16.0 is supported but you need to use the search field
in the Create a new project dialog box in order to find the COBOL project templates).
You need one of the advanced versions of Visual Studio listed below:
Professional, Enterprise or Community Edition (for Visual Studio 2017) - see the next section for the
Visual Studio components you must install.
Professional, Enterprise or Community Edition (for Visual Studio 2019) - see the next section for the
Visual Studio components you must install.
Microsoft's Visual Studio Express Edition is not supported.
Important:
•

When installing Visual Studio, ensure you select the Help Viewer component for installing if you
want to view the Visual COBOL product help inside Visual Studio. When you select components to
install in the Visual Studio installer, click Individual components and check Help Viewer in the
Code tools section.

The following software is also required:
•

Microsoft .NET Framework 4.7.2. This is included with Visual Studio.

Selecting the Visual Studio components to install
The Visual Studio installer enables you to customize and only install the workloads and components that
are most suitable for your area of development. For example, you can select the components that are
required for .NET desktop development, ASP.NET Web or C++ development.
If not already installed, the Visual COBOL setup file will install the following components:
•
•
•

.NET Framework version 4.7.2.
Debugger
Data services

A number of workloads and components are optional and only required by specific types of applications or
tasks:
•

Azure, WCF, Web, WPF or SQL CLR application development.

If you require any of these, you can select them when you start the Visual Studio installer or, enable them
after completing the installation - see the next section.
Installing Visual Studio features that are not currently installed
If a feature of Visual Studio was not installed during the Visual Studio installation, the respective
functionality or the project templates for it are not available. You can install a missing feature in one of the
following ways:
Rerun the Visual Studio installer:
1. Start the Visual Studio installer and choose to modify an existing Visual Studio instance.
2. Select the workloads and the components that are missing (for example, ASP.NET and web
development or Help Viewer).
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3. Start the Visual Studio installation.
Use the Quick Launch control in Visual Studio:
1. Start Visual Studio.
2. Type the name of the feature in the Quick Launch control - for example, type ASP.NET or Help
Viewer.
A drop-down list with any features matching your search string appears. If the feature is not already
installed, one of the search results will be an option to install it.
Use the Install Missing Feature(s) command in Visual Studio:
1. Start Visual Studio.
2. Click Help > Micro Focus Product Help > Install Missing Feature(s) > Feature Name.
Follow the instructions in the installer to install the missing feature.
3. Alternatively, if a Micro Focus project template requires a Visual Studio feature which is not currently
installed, the IDE displays an information bar with instructions to install the feature.
Other Requirements
Important: For local servers, you do not need to install the Micro Focus License Administration tool
separately, as the setup file installs a new Visual COBOL client and a new licensing server on the
same machine.
If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus License Administration tool. To check the version of the license server on UNIX, run /var/
microfocuslicensing/bin/mfcesver or /var/microfocuslicensing/bin/
cesadmintool.sh.
If Micro Focus License Manager version 10000.2.02070 or older is installed, it must be uninstalled
before the product installation or upgrade can continue.
You can download the new version of the license server software from the Micro Focus SupportLine
Web site: http://supportline.microfocus.com.

System Requirements for Visual COBOL for Eclipse (Windows)
Hardware Requirements
Visual COBOL has the following requirements in addition to the requirements of Eclipse. See the Eclipse
documentation for details of its requirements.
The disk space requirements are, approximately:
Visual COBOL
2.6GB

Note: The disk space requirements include the size of the Eclipse IDE and the version of Java and
the .NET Framework provided with the Visual COBOL setup file. This includes the space needed to
cache information locally so that you can modify the installation without the original source media.
Operating Systems Supported
For a list of the supported operating systems, check the Product Availability section on the Micro Focus
SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.
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Note:
•

Support for development on Windows 8 and Windows Server 2012 has been discontinued. These
platforms are still supported for deployment. Windows 8.1 and Windows Server 2012 R2 are
supported.

•

Visual COBOL installs fully only on 64-bit Windows platforms. On 32-bit Windows, the setup file
does not install some of the components. See Issues with the Installation in Known Issues and
Restrictions.
Visual COBOL enables you to produce both 64-bit and 32-bit applications on 64-bit operating
systems.

•

Software requirements
Note: This product includes OpenSSL version 1.1.1b.
The setup file will check your machine for whether the prerequisite software is installed and will install any
missing prerequisites and the product components.
Eclipse requirements
•

•
•

The setup file installs Visual COBOL and the 64-bit Eclipse 4.8.
Some earlier versions of Eclipse are also supported. See Installing Visual COBOL into other instances
of Eclipse in the Advanced Installation Tasks.
Visual COBOL installs fully only on 64-bit Windows platforms. On 32-bit Windows, the setup file does
not install some of the components. See Issues with the Installation in Known Issues and Restrictions.
Visual COBOL supports both the 32-bit and the 64-bit Eclipse. You can use the 64-bit Eclipse to create
both 32-bit and 64-bit applications.

Software requirements
•

Java 8 (64-bit) is required to run the Eclipse IDE. The minimum recommended version is
AdoptOpenJDK's OpenJDK 8 (u202) with Hotspot, which the Windows product installs automatically.
Java 8 (32 or 64-bit versions), and Java 11 (64-bit version only) are supported for executing JVM
COBOL code and for native COBOL and Java interoperability. You can download AdoptOpenJDK's
OpenJDK 8 with Hotspot from AdoptOpenJDK's Web site and unpack the archive anywhere on your
machine.
Note: Eclipse does not run using Java 11.

•

Visual COBOL requires:

•

• A 32-bit Java installation if using the 32-bit Eclipse.
• A 64-bit Java installation if using the 64-bit Eclipse.
The setup file also installs Microsoft's Visual C++ 2012, 2013 and 2017 Redistributables.

See Java Support Restrictions in the product help for any considerations when using Eclipse and Java.
Important: For local servers, you do not need to install the Micro Focus License Administration tool
separately, as the setup file installs a new Visual COBOL client and a new licensing server on the
same machine.
If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus License Administration tool. To check the version of the license server on UNIX, run /var/
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microfocuslicensing/bin/mfcesver or /var/microfocuslicensing/bin/
cesadmintool.sh.
If Micro Focus License Manager version 10000.2.02070 or older is installed, it must be uninstalled
before the product installation or upgrade can continue.
You can download the new version of the license server software from the Micro Focus SupportLine
Web site: http://supportline.microfocus.com.

System Requirements for Visual COBOL for Eclipse (UNIX)
Hardware Requirements for Visual COBOL for Eclipse
Visual COBOL has the following requirements in addition to the requirements of Eclipse. See the Eclipse
documentation for details of its requirements.
The disk space requirements are approximately:
Platform

Installer type

Setup

Disk space

Disk space

Sentinel RMS

file size

required for

required for

the installation

running

license
server

the product
x86-64
running Red
Hat Linux

Micro Focus

905 GB

3.62 GB

1.81 GB

50 MB

x64 running
SUSE SLES

Micro Focus

781 GB

3.12 GB

1.56 GB

50 MB

Operating Systems Supported
Note: You can produce both 64-bit and 32-bit applications on 64-bit operating systems.
For a list of the supported operating systems, check the Product Availability section on the Micro Focus
SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.
Software Requirements
Eclipse requirements
•
•
•
•

Visual COBOL installs the 64-bit Eclipse IDE by default and requires a 64-bit Java installation.
On SUSE 12, you can only install and use the 64-bit version of Visual COBOL.
On other platforms, Visual COBOL supports both the 32-bit and the 64-bit Eclipse. You can use the 64bit Eclipse to create both 32-bit and 64-bit applications.
The setup file installs Visual COBOL and the 64-bit Eclipse 4.8. After the installation, you can install
Visual COBOL as a plug-in into other Eclipse installations available on the same machine. The
supported versions are 4.7, and 4.8 for both the 32-bit and the 64-bit Eclipse. See Installing Visual
COBOL into other instances of Eclipse.
Note: On Red Hat platforms, you need Red Hat 7 or later, if you want to install Visual COBOL into
Eclipse 4.8.

Other software requirements
Before installing this product, you must have the following software installed on your computer:
•
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The unzip utility is required by the setup file.

•
•

•

The "awk", "ed", "sed" and "tar" utilities must be installed and added to the PATH.
The pax archiving utility is required by the setup file. Pax is distributed with most UNIX/Linux systems
but, if it is missing, you must install it separately. To verify pax is installed, run pax --help or pax -version at the command line.
Required libraries - the 32-bit libraries listed below are required on both 32-bit and on 64-bit Operating
Systems for this product to install and work correctly.
If installing on a 64-bit OS, the 32-bit libraries are not installed by default and must be installed before
you start the installation.
Library

32-bit
Library
Name

64-bit
Library
Name

Platform
s390

SUSE 12¹

Red Hat 6.x

Red Hat 7

glibc

glibc-*.i686

glibc*.x86_64

glibc-*.s390

X

X

libgcc

libgcc-*.i686

libgcc*.x86_64

libgcc-*.s390

X

X

libstdc++

libstdc++*.i686

libstdc++*.x86_64

libstdc++*.s390

X

X

glibc-locale

glibclocale-32bit

glibc-locale-2 N/A

X

gtk2

N/A

libgtk-2_0-02

N/A

X

gtk2

N/A

gtk2-tools-2

N/A

X

gtk2

N/A

libXcomposit N/A
e1-0

X

gtk2

N/A

libgdk_pixbuf N/A
-2_0-0-2

X

gtk2

N/A

gdk-pixbufqueryloaders-2

N/A

X

gtk2

N/A

libjasper1-1

N/A

X

gtk2

N/A

gtk2*.x86_64

N/A

X

X

gtk2-x11

N/A

libgthread-2_ N/A
0-0-2

X

libXtst

N/A

libXtst6-1

N/A

X

libXtst

N/A

libXtst*.x86_64

N/A

X

X

glibc-devel

glibc-devel*.i686

glibc-devel*.x86_64

N/A

X

X

PackageKitgtk

N/A

PackageKitgtk-module*.x86_64

N/A

X

PackageKitgtk3

N/A

PackageKit- N/A
gtk3-module*.x86_64

X
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Library

32-bit
Library
Name

64-bit
Library
Name

Platform
s390

SUSE 12¹

Red Hat 6.x

Red Hat 7

gtk2-engines N/A

gtk2engines.*.x8
6_64

N/A

X

libcanberragtk2

N/A

libcanberragtk2*.x86_64

N/A

X

webkitgtk

N/A

webkitgtk.x8
6_64

N/A

X

webkitgtk3

N/A

webkitgtk3.x
86_64

N/A

xterm

Any version

Any version

Any version

X

X

X

unzip

Any version

Any version

Any version

X

X

X

libgnome

N/A

libgnome.x86 N/A
_64

X

X

gcc2

gcc*.i686

gcc*x86_64

X

X

cpp2

cpp*x86_64

libnotifytools3

libnotifytools*x86_64

X

X

X

X

X
X

X

Note:
•
•
•
•
•

¹ On SuSe 12, you can only install the 64-bit version of Visual COBOL. The glibc-locale-32bit
library is still required by the SafeNet Sentinel licensed components.
* Additional libraries required to use the core_on_error runtime variable. The gdb packages (for
the GNU Project Debugger) can be installed from the install media for your OS.
2 On Red Hat these libraries are required to enable COBOL to compile.
Libraries marked with an 'X' are not included in the platform and need to be installed separately.
3 For SUSE 12 and later, you might need to install the Notifications Library tools (libnotify-tools).
This is to enable notifications to be displayed by the notify-send tool when starting Visual
COBOL for Eclipse from a desktop icon. Execute the following command to install the libnotifytools library:
zypper install libnotify-tools

Visit the Red Hat Web site for more information.
•

Xterm, the terminal emulator for the X Window System, is part of your UNIX/Linux distribution but is not
installed by default. Use your UNIX/Linux installation media to install it.

•

Java 8 (64-bit) is required to run the Eclipse IDE. The minimum recommended version is
AdoptOpenJDK's OpenJDK 8 (u202) with Hotspot, which the Windows product installs automatically.
Java 8 (32 or 64-bit versions), and Java 11 (64-bit version only) are supported for executing JVM
COBOL code and for native COBOL and Java interoperability. You can download AdoptOpenJDK's
OpenJDK 8 with Hotspot from AdoptOpenJDK's Web site and unpack the archive anywhere on your
machine.
Note: Eclipse does not run using Java 11.

Before you start the installation, you need to set the environment as follows:
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•

•
•

You need to set the JAVA_HOME environment variable. When installing the product, set this variable to
a 64-bit Java installation or the installation terminates. For example, execute the following:
export JAVA_HOME=java_install_dir
where java_install_dir is the path to the JAVA installation directory such as /usr/java/javan.n
You need to add $JAVA_HOME/bin to your system PATH variable. To do this, execute:
export PATH=$JAVA_HOME/bin:$PATH
You need to set the LANG environment variable to pick up localized messages. The LANG settings are
English and Japanese only.
Important: For local servers, you do not need to install the Micro Focus License Administration tool
separately, as the setup file installs a new Visual COBOL client and a new licensing server on the
same machine.
If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus License Administration tool. To check the version of the license server on UNIX, run /var/
microfocuslicensing/bin/mfcesver or /var/microfocuslicensing/bin/
cesadmintool.sh.
If Micro Focus License Manager version 10000.2.02070 or older is installed, it must be uninstalled
before the product installation or upgrade can continue.
You can download the new version of the license server software from the Micro Focus SupportLine
Web site: http://supportline.microfocus.com.

System Requirements for Visual COBOL Development Hub
Hardware Requirements
The disk space requirements are approximately:
Platform

Installer type

Setup

Disk space

Disk space

Sentinel RMS

file size

required for

required for

the installation

running

license
server

the product
POWER
running AIX

Micro Focus

462 MB

1.85 GB

924 MB

41 MB

HP IA

Micro Focus

847 MB

3.39 GB

1.74 GB

79 MB

System Z
running Red
Hat Linux

Micro Focus

382 MB

1.53 GB

764 MB

39 MB

x86-64
running Red
Hat Linux

Micro Focus

455 MB

1.82 GB

910 MB

50 MB

ppc64le
running Red
Hat Linux

Micro Focus

267 MB

1.07 GB

534 MB

1 MB

SPARC
running
Solaris

Micro Focus

456 MB

1.82 GB

912 MB

41 MB

x86-64
running
Solaris

Micro Focus

431 MB

1.72 GB

862 MB

33 MB
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Platform

Installer type

Setup

Disk space

Disk space

Sentinel RMS

file size

required for

required for

the installation

running

license
server

the product
System Z
Micro Focus
running SUSE
SLES

280 MB

1.12 GB

560 MB

39 MB

x64 running
SUSE SLES

Micro Focus

333 MB

1.33 GB

666 MB

50 MB

ppc64le
Micro Focus
running SUSE
SLES

247 MB

988 MB

494 MB

1 MB

Operating Systems Supported
For a list of the supported operating systems, check the Product Availability section on the Micro Focus
SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.
Software Requirements
Note: This product includes OpenSSL version 1.1.1b.
Before installing this product, you must have the following software installed on your computer:
•

Xterm, the terminal emulator for the X Window System, is part of your UNIX/Linux distribution but is not
installed by default. Use your UNIX/Linux installation media to install it.

•
•
•

The "awk", "ed", "sed" and "tar" utilities must be installed and added to the PATH.
On SUSE 12, you can only install and use the 64-bit version of Visual COBOL.
The pax archiving utility is required by the setup file. Pax is distributed with most UNIX/Linux systems
but, if it is missing, you must install it separately. To verify pax is installed, run pax --help or pax -version at the command line.
Required libraries for Red Hat and SUSE Linux platforms - the installer checks that both the 32-bit and
64-bit libraries listed below are installed on both 32-bit and on 64-bit Operating Systems for this product
to install and work correctly.

•

If installing on a 64-bit OS, the 32-bit libraries are not installed by default and must be installed before
you start the installation.
Table 1: Default Libraries
The following table shows which of the required libraries are not installed by default on the specified platforms - X
indicates the libraries are missing.
Library
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32-bit
Library
Name

64-bit
Library
Name

s390
Library Name

Platform
SUSE 12¹

Red Hat 7

glibc

glibc-*.i686

glibc*.x86_64

glibc-*.s390

X

libgcc

libgcc-*.i686

libgcc*.x86_64

libgcc-*.s390

X

libstdc++

libstdc++*.i686

libstdc++*.x86_64

libstdc++-*.s390

X

Library

32-bit
Library
Name

64-bit
Library
Name

s390
Library Name

Platform
SUSE 12¹

Red Hat 7

glibc-devel

glibc-devel*.i686

glibc-devel*.x86_64

glibc-devel-*.s390

X

glibc-locale

glibclocale-32bit

glibc-locale-2

N/A

X

gtk2

N/A

libgtk-2_0-0-2 N/A

X

gtk2

N/A

gtk2-tools-2

N/A

X

gtk2

N/A

libXcomposite N/A
1-0

X

gtk2

N/A

libgdk_pixbuf- N/A
2_0-0-2

X

gtk2

N/A

gdk-pixbufqueryloaders-2

N/A

X

gtk2

N/A

libjasper1-1

N/A

X

gtk2

N/A

gtk2-*.x86_64 N/A

gtk2-x11

N/A

libgthread-2_
0-0-2

N/A

X

libXtst

N/A

libXtst6-1

N/A

X

libXtst

N/A

libXtst*.x86_64

N/A

X

glibc-devel

glibc-devel*.i686

glibc-devel*.x86_64

N/A

X

PackageKitgtk

N/A

PackageKitgtk-module*.x86_64

N/A

PackageKitgtk3

N/A

PackageKitgtk3-module*.x86_64

N/A

gtk2-engines

N/A

gtk2N/A
engines.*.x86
_64

libcanberragtk2

N/A

libcanberraN/A
gtk2-*.x86_64

webkitgtk

N/A

webkitgtk.x86 N/A
_64

webkitgtk3

N/A

webkitgtk3.x8 N/A
6_64

xterm

Any version

Any version

Any version

X

X

unzip

Any version

Any version

Any version

X

X

libgnome

N/A

libgnome.x86 N/A
_64

X

X

X

X

X
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Library

gcc2

32-bit
Library
Name
gcc*.i686

cpp2

64-bit
Library
Name

s390

Platform

Library Name

gcc*x86_64

X

cpp*x86_64

SUSE 12¹

Red Hat 7

X

X
X

Visit the Red Hat Web site for more information.
•
•
•

¹ On SuSe 12, you can only install the 64-bit version of Visual COBOL. The glibc-locale-32bit library
is still required by the SafeNet Sentinel licensed components.
2 On Red Hat these libraries are required to enable COBOL to compile.

Java 8 (64-bit) is required to run the Eclipse IDE. The minimum recommended version is
AdoptOpenJDK's OpenJDK 8 (u202) with Hotspot, which the Windows product installs automatically.
Java 8 (32 or 64-bit versions), and Java 11 (64-bit version only) are supported for executing JVM
COBOL code and for native COBOL and Java interoperability. You can download AdoptOpenJDK's
OpenJDK 8 with Hotspot from AdoptOpenJDK's Web site and unpack the archive anywhere on your
machine.
Note: Eclipse does not run using Java 11.
Note:
•

•
•

On AIX and zLinux, you need to have IBM's JDK. The earliest supported release of IBM's JDK
is 7.0 Service Refresh 8. If you install IBM's JDK 8, on AIX you must install its latest fix - JDK 8
SR5 FP16. You can get IBM's AIX JDK from IBM's Web site.
On HP-UX, you need to have HP-UX JDK. The earliest supported release of HP-UX is JDK
7.0.11. You can get the HP-UX Java JDK from HP's Web site.
On Solaris platforms (both SPARC and Intel) only the 64-bit version of Java 8 and later is
supported.

To execute JVM COBOL code, you need to set the environment as follows:
•

•
•

You need to set the JAVA_HOME environment variable. When installing the product, set this variable to
a 64-bit Java installation or the installation terminates. For example, execute the following:
export JAVA_HOME=java_install_dir
where java_install_dir is the path to the JAVA installation directory such as /usr/java/javan.n
You need to add $JAVA_HOME/bin to your system PATH variable. To do this, execute:
export PATH=$JAVA_HOME/bin:$PATH
You need to set the LANG environment variable to pick up localized messages. The LANG settings are
English and Japanese only.
Important: For local servers, you do not need to install the Micro Focus License Administration tool
separately, as the setup file installs a new Visual COBOL client and a new licensing server on the
same machine.
If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus License Administration tool. To check the version of the license server on UNIX, run /var/
microfocuslicensing/bin/mfcesver or /var/microfocuslicensing/bin/
cesadmintool.sh.
If Micro Focus License Manager version 10000.2.02070 or older is installed, it must be uninstalled
before the product installation or upgrade can continue.
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You can download the new version of the license server software from the Micro Focus SupportLine
Web site: http://supportline.microfocus.com.

UNIX and Linux Installer Issues
•

If you reinstall Visual COBOL for Eclipse on a UNIX machine, it is possible that Eclipse will start without
loading the Micro Focus features. To solve this, you must delete the .eclipse folder in your home
directory and restart Visual COBOL.

Installing on Linux
On Linux, the RPM installer for Visual COBOL for Eclipse installs a 64-bit version of Java. When you start
the installation, if the 32-bit version of Java is already installed on your Linux machine, you might not be
able to install Visual COBOL. This is a known issue with the Oracle Java installers for Linux which prevents
you from installing both the 32-bit and the 64-bit versions of Java on the same machine. To work around
this problem:
•
•
•

Download the 64-bit Java distribution in a compressed .tar format from the Oracle Web site.
Untar the distribution into a location different from the one used for the 32-bit Java version. For example,
untar in /usr/local/java64 and not in /usr/local/java.
Set JAVA_HOME and LD_LIBRARY_PATH to the 64-bit version of Java so that it is used to install and
run Visual COBOL.

Installing while using AFS/Kerberos authentication
If you are using AFS/Kerberos authentication to log onto your Linux system then you need to ensure you
have a local user ID which SOA and Visual COBOL components of the product can use. This user ID must
be set up prior to running the installer. When running the installer you need to specify ESadminID=[User ID] on the command line so it is used by the installer.
License Server
You need to configure the computer hostname to ensure the license server will start properly.
To avoid performance issues, "localhost" and the computer hostname must not both be mapped to IP
address 127.0.0.1. You should only map "localhost" to IP address 127.0.0.1.
The following is an example of how to specify these entries correctly in the /etc/hosts file:
127.0.0.1 localhost.localdomain localhost
IP machinelonghostname machineshorthostname
where IP is the unique IP address of the computer in xx.xx.xx.xx format.

Product Co-Existence
Note: The following applies to Windows only.
•
•

Visual COBOL and COBOL Server cannot coexist on the same machine.
Visual COBOL and Enterprise Developer cannot coexist on the same machine regardless of which IDE
(Visual Studio or Eclipse) you install.

Basic Installation
The instructions in this section apply when you are performing a basic installation of this product for the
first time. If you are an administrator, you can perform a basic installation on a local machine before
performing a more advanced installation when rolling out the product to developers within your
organization.
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For considerations when installing this product as an upgrade, for additional installation options or nondefault installations, see Advanced Installation Tasks in your product Help.

Installing Visual COBOL for Visual Studio
To install this product:
1. Run the vcvsnnnn_30.exe file (where nnnn is the version of Visual Studio you're installing for) and
follow the wizard instructions to install the prerequisite software and the product.
Note:
•

•

•
•
•

If you are installing onto a machine that has an existing Micro Focus product that uses an older
Sentinel RMS License Manager, you might be prompted to remove it and install the Micro Focus
License Administration. By doing this you maintain the existing Sentinel RMS license files while
adding the Micro Focus License Administration. If you are unsure about existing licenses on your
computer or removing the Sentinel RMS License Manager, consult your System Administrator. If
you want to proceed, remove Sentinel RMS License Manager by using Program and Features
(Windows Vista or later), and rerun the installation file.
If do not choose to install Rumba+ at this time, but decide you want it later, you must then uninstall
Visual COBOL, and then rerun the installer with the Rumba+ option checked. As an alternative,
you can use a different emulator, but be aware that instructions in this documentation often
assume that you are using the embedded Rumba+ Desktop emulator.
Trial licenses cannot be used with remote desktop services. If you want to use your product in this
way, please contact Micro Focus SupportLine to obtain a relevant license.
We recommend that you install any updates for Visual Studio and the .NET Framework that are
available at the Microsoft Download site.
If you install JDK you might be prompted to install the latest update. The latest update is not
required for use with Visual COBOL but you can install it if you wish.

Installing Visual COBOL for Eclipse (Windows)
Note:
•
•

This version of the product is a full install.
If you have an earlier version of Visual COBOL installed on your machine, check Installing as an
Upgrade before you start the installation - see Advanced Installation Tasks.

These are the steps to install Visual COBOL:
1. Run the vce_50.exe file and follow the wizard instructions to complete the installation.
By default, this installs Visual COBOL in the %ProgramFiles(x86)%\Micro Focus\Visual
COBOL folder and installs a full version of Eclipse 4.8 64-bit, with the Micro Focus plugins already
installed, in the C:\Users\Public\Micro Focus\Product Name\eclipse directory.
The setup file installs any missing prerequisite software as listed in the topic Software Requirements.
Note: See Advanced Installation Tasks for information about non-default installation tasks.

Installing Visual COBOL for Eclipse (UNIX)
Note: Micro Focus offers two types of installers on UNIX and Linux - a proprietary Micro Focus
installer for installing Visual COBOL on UNIX and Linux and a standard RPM (RPM Package
Manager) installer for installing Visual COBOL on Linux. See your product Help for instructions on
how to use the RPM installer.
These are the steps to install this product using the Micro Focus installer:
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1. Give execute permissions to the setup file:
chmod +x setup_visualcobol_deveclipse_5.0_platform
2. Run the setup file with superuser permissions:
./setup_visualcobol_deveclipse_5.0_platform
If you don't run this as superuser, you are prompted to enter the superuser password during the install.
The COBOL environment is installed by default into /opt/microfocus/VisualCOBOL, (COBDIR). A
full version of Eclipse, with the Micro Focus plugins already installed, is present in the $COBDIR/
eclipse directory.
To install in a different location use the -installlocation="Location" parameter to specify an
alternative directory location. For example:
./setup_visualcobol_deveclipse_5.0_platform -installlocation="full path of
new location"
Note: You can use variables when specifying an absolute path for –installlocation. For
example, the following examples are equivalent:
-installlocation="/home/myid/installdir"
-installlocation="$HOME/installdir"
You can see details about which additional parameters can be passed to the install script if you enter
the -help option.
Note:
•

•

The installation of this product could affect the SafeNet Sentinel licensed components running
on your machine. During installation licensing is shutdown to allow files to be updated. To
ensure the processes running on your machine are not affected, you need to use the skipsafenet option, which skips the installation of SafeNet:
. /setup_visualcobol_deveclipse_5.0_platform -skipsafenet
To protect the SafeNet Sentinel installation from accidental updating you can create an empty
file named SKIP_SAFENET_INSTALL in /var/microfocuslicensing/ as follows:
touch /var/microfocuslicensing/SKIP_SAFENET_INSTALL
While the file is present, the SafeNet installer does not make changes to the installation or
shutdown the running license daemons. If licensing needs to be updated later, remove the file
and install Sentinel RMS server manually.

Installing Visual COBOL Development Hub
Note: Micro Focus offers two types of installers on UNIX and Linux - a proprietary Micro Focus
installer for installing on UNIX and Linux and a standard RPM (RPM Package Manager) installer for
installing on Linux. See your product Help for instructions on how to use the RPM installer.
These are the steps to install this product using the Micro Focus installer:
1. Give execute permissions to the setup file:
chmod +x setup_visualcobol_devhub_5.0_platform
2. Run the installer with superuser permissions:
./setup_visualcobol_devhub_5.0_platform
If you don't run this as superuser you will be prompted to enter the superuser password during the
installation.
The COBOL environment is installed by default into /opt/microfocus/VisualCOBOL, (COBDIR).
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SafeNet Sentinel considerations
•

•

The installation of this product could affect the SafeNet Sentinel licensed components running on your
machine. During installation licensing is shutdown to allow files to be updated. To ensure the processes
running on your machine are not affected, you need to use the -skipsafenet option, which skips the
installation of SafeNet:
./setup_visualcobol_devhub_5.0_platform -skipsafenet
To protect the SafeNet Sentinel installation from accidental updating you can create an empty file
named SKIP_SAFENET_INSTALL in /var/microfocuslicensing/ as follows:
touch /var/microfocuslicensing/SKIP_SAFENET_INSTALL
While the file is present, the SafeNet installer does not make changes to the installation or shutdown the
running license daemons. If licensing needs to be updated later, remove the file and install Sentinel
RMS server manually.
Note:
During the installation process, the installer configures the product's Enterprise Server System
Administrator Process User ID. The Process User ID will be the owner of all Enterprise Server
processes except the one for the Micro Focus Directory Server (MFDS). The Directory Server process
(Enterprise Server Administration) runs as root as this allows it to access the system files and ports.
All Enterprise Server processes you start from Enterprise Server Administration run under the
Process User ID which can affects the file access and creation.
By default, the installer uses the login id of the user that runs the installer for the Process User ID. To
change the user id after you complete the installation, execute $COBDIR/bin/casperm.sh.

After Installing
•
•
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See Changes in Behavior or Usage in your product documentation and in the Release Notes for
important information about changes in this release that might affect existing applications.
Check the Product Documentation section of the Micro Focus SupportLine Web site for any updates to
the documentation which might have been uploaded.

Licensing Information
Note:
•
•

•
•
•
•

Personal Edition licensing is only available with Visual COBOL for Visual Studio 2019 and Visual
COBOL for Eclipse
When you activate Visual COBOL Personal Edition, you can use it for a limited period of 365 days.
After this period, you can either register a new Personal Edition license for 365 days or acquire a
valid license either for a 30-day trial or full license of Visual COBOL in order to continue using the
product.
This package provides eight licenses for using Micro Focus Development Hub on all platforms.
If you have purchased licenses for a previous release of this product, those licenses will also
enable you to use this release.
The latest version of the SafeNet licensing software is required. See the Software Requirements
section in this document for more details.
If you are unsure of what your license entitlement is or if you wish to purchase additional licenses,
contact your sales representative or Micro Focus SupportLine.

To buy and activate a full unlimited license
To buy a license for Visual COBOL, contact your sales representative or Micro Focus SupportLine.
For instructions on using the Micro Focus Licensing Administration Tool, see Licensing in the Visual
COBOL help.

To start Micro Focus License Administration
Windows
Windows 8.1

•

Windows 10 and Later •

From the Windows Start screen, click the License Administration tile
From your Windows desktop, click Start > Micro Focus License Manager >
License Administration

UNIX
Log on as root, and from a command prompt type:
/var/microfocuslicensing/bin/cesadmintool.sh

Installing licenses
You need either a license file (with a .mflic extension) or an authorisation code which consists of a string
of 16 alphanumeric characters.
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If you have a license file
Windows
1. Start Micro Focus License Administration.
2. Click the Install tab.
3. Do one of the following:
•

Click Browse next to the License file field and select the license file (which has an extension
of .mflic).
• Drag and drop the license file from Windows Explorer to the License file field.
• Open the license file in a text editor, such as Notepad, then copy and paste the contents of the file
into the box below the License file field.
4. Click Install Licenses.
Alternatively, you can install the license file from within the IDE as follows:
1. Start Visual COBOL.
2. Click Help > Micro Focus Product Help > Product LicensingHelp > Micro Focus > Product
Licensing to open the Product Licensing dialog box.
3. Ensure I have a full Visual COBOL license is checked.
4. Click Browse next to the License file field.
5. Select the license file (which has an extension of .mflic), and then click Open.
6. Click AuthorizeFinish to install the license.
You should see a dialog box with a confirmation that the licenses have been installed successfully.
UNIX
1. Start the Micro Focus License Administration tool and select the Manual License Installation option by
entering 4.
2. Enter the name and location of the license file.

If you have an authorization code
Authorizing your product when you have an Internet connection
Note:
•

It is not possible to install licenses remotely. You must be logged into the machine on which you
are installing the licenses.

The following procedure describes how to authorize your product using a local or network license server.
The license server is set up automatically when you first install the product.
Windows
1.
2.
3.
4.

Start Micro Focus License Administration.
Click the Install tab.
Type the authorization code in the Enter authorization code field.
Click Authorize.

If you change the name of the machine running your license server after it has granted licenses, the
licenses stop working.
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UNIX
1. Start Micro Focus License Administration.
2. Select the Online Authorization option by entering 1 and pressing Enter.
3. Enter your authorization code at the Authorization Code prompt and then press Enter.

Authorizing your product when you don't have an Internet connection
This method of authorization is required if the machine you want to license does not have an Internet
connection or if normal (automatic) authorization fails.
Windows
1.
2.
3.
4.

Start Micro Focus License Administration.
Click Manual Authorization on the Install page.
Make a note of the contents of the Machine ID field. You will need this later.
Do one of the following:
•
•

If your machine has an Internet connection, click the SupportLine Web link in the Manual
Authorization Information window.
If your machine does not have an Internet connection, make a note of the Web address and type it
into a Web browser on a machine that has an Internet connection.

The Micro Focus SupportLine Manual product authorization Web page is displayed.
5. Type the authorization code in the Authorization Code field. The authorization code is a 16-character
alphanumeric string supplied when you purchased your product.
6. Type the Machine ID in the Machine ID field.
7. Type your email address in the Email Address field.
8. Click Generate.
9. Copy the generated license string (or copy it from the email) and paste it into the box under the License
file field on the Install page.
10.Click Install Licenses.
UNIX
In order to authorize your product you must have the following:
•
•
•

Access to a computer which is connected to the Internet.
Your authorization code (a 16-character alphanumeric string).
The machine ID. To get this, start the Micro Focus License Administration tool and select the Get
Machine Id option by inputting 6. Make a note of the "Old machine ID".

If you have previously received the licenses and put them in a text file, skip to step 6.
1. Open the Micro Focus license activation web page http://supportline.microfocus.com/activation in a
browser.
2. Enter your authorization code and old machine ID and, optionally, your email address in the Email
Address field.
3. Click Generate.
4. Copy the licenses strings from the web page or the email you receive into a file.
5. Put the license file onto your target machine.
6. Start the Micro Focus License Administration tool and select the Manual License Installation option by
inputting 4.
7. Enter the name and location of the license file.
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To obtain more licenses
If you are unsure of what your license entitlement is or if you wish to purchase additional licenses for Visual
COBOL, contact your sales representative or Micro Focus SupportLine.
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Updates and SupportLine
Our Web site gives up-to-date details of contact numbers and addresses.

Further Information and Product Support
Additional technical information or advice is available from several sources.
The product support pages contain a considerable amount of additional information, such as:
•

•

•

The Product Updates section of the Micro Focus SupportLine Web site, where you can download fixes
and documentation updates. Go to https://supportline.microfocus.com/websync/
productupdatessearch.aspx
The Examples and Utilities section of the Micro Focus SupportLine Web site, including demos and
additional product documentation. Go to https://supportline.microfocus.com/examplesandutilities/
index.aspx.
The Support Resources section of the Micro Focus SupportLine Web site, that includes troubleshooting
guides and information about how to raise an incident. Go to https://supportline.microfocus.com/
supportresources.aspx

To connect, enter https://www.microfocus.com in your browser to go to the Micro Focus home page, then
click Support & Services > Support > Support Resources > All Support Resources by Product. In the
Browse by Product field, click the product you require, and then click Log into SupportLine.
Note: Some information may be available only to customers who have maintenance agreements.
If you obtained this product directly from Micro Focus, contact us as described on the Micro Focus Web
site, https://www.microfocus.com/support-and-services/contact-support/. If you obtained the product from
another source, such as an authorized distributor, contact them for help first. If they are unable to help,
contact us.
Also, visit:
•

•

The Micro Focus Community Web site, where you can browse the Knowledge Base, read articles and
blogs, find demonstration programs and examples, and discuss this product with other users and Micro
Focus specialists. See https://community.microfocus.com.
The Micro Focus YouTube channel for videos related to your product - see https://www.youtube.com/
user/MicroFocusIntl.

Information We Need
However you contact us, please try to include the information below, if you have it. The more information
you can give, the better Micro Focus SupportLine can help you. But if you don't know all the answers, or
you think some are irrelevant to your problem, please give whatever information you have.
•
•
•
•
•
•

The name and version number of all products that you think might be causing a problem.
Your computer make and model.
Your operating system version number and details of any networking software you are using.
The amount of memory in your computer.
The relevant page reference or section in the documentation.
Your serial number. To find out these numbers, look in the subject line and body of your Electronic
Product Delivery Notice email that you received from Micro Focus.
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On Windows, if you are reporting a protection violation you might be asked to provide a dump ( .dmp) file.
To produce a dump file you use the Unexpected Error dialog box that is displayed when a protection
violation occurs. Unless requested by Micro Focus SupportLine, leave the dump setting as Normal
(recommended), click Dump, then specify a location and name for the dump file. Once the dump file has
been written you can email it to Micro Focus SupportLine.
Alternatively, you might be asked to provide a log file created by the Consolidated Tracing Facility (CTF) - a
tracing infrastructure that enables you to quickly and easily produce diagnostic information detailing the
operation of a number of Micro Focus software components.
On Windows, you can use the Micro Focus SupportLine Support Scan Utility, MFSupportInfo, to create
either:
•
•

a .log file that contains the details about your environment, Micro Focus SupportLine products, and
settings.
a .zip archive that includes the same information as the .log file plus some product configuration
files from c:\ProgramData and the product installation log files.

MFSupportInfo.exe is stored in <install-dir>\bin.
To run MFSupportInfo:
1. Start a 32-bit Enterprise Developer command prompt.
2. Enter MFSupportinfo at the command prompt to start the utility.
3. Create a .log file or a .zip archive as follows:
a. To create a .log file, click File > Save.
This prompts to save the .log file, MFSupportInfo_Log_MachineName_YYYY-MM-DD_HH-MMSS.log, in the %temp% directory.
b. To create a .zip archive, click Tools > Create Zip Package.
This creates a .zip archive, MFSupportInfo_Log_MachineName_YYYY-MM-DD_HH-MMSS.zip, in the %temp% directory.
4. Send the diagnostic information to your Micro Focus SupportLine representative:
The following requires an Internet connection and an Email client:
a. Click Tools > Email Log to SupportLine to open the Email Log dialog box.
b. Fill in the required fields and click Send.
If the machine is not connected to the Internet or if there are no Email clients installed, copy either
the .log file or the .zip archive to a machine that is connected to the Internet. Use your Email client
to email the files to Micro Focus SupportLine at supportline@microfocus.com together with the Support
Incident (SI) number, if available, and any additional details that might be useful to diagnose the issues
that you are experiencing.
On UNIX, you can use the Micro Focus UNIX Support Scan Utility, mfsupport, to create a log file that
contains the details about your environment, product, and settings. The mfsupport script is stored in
$COBDIR/bin.
To run mfsupport:
1. Start a UNIX shell.
2. Set COBDIR to the product with issues.
3. Execute mfsupport from a directory where you have write permissions.
This creates a log file, mfpoll.txt, in that directory.
4. When the script finishes, send the mfpoll.txt file to your Micro Focus SupportLine representative.

68

| Updates and SupportLine

Note:
If COBDIR is set to a location that does not contain etc/cobver, the script outputs the contents
of /opt/microfocus/logs/MicroFocusProductRegistry.dat which keeps a list of the
installed Micro Focus products.

Creating Debug Files
If you encounter an error when compiling a program that requires you to contact Micro Focus SupportLine,
your support representative might request that you provide additional debug files (as well as source and
data files) to help us determine the cause of the problem. If so, they will advise you how to create them.
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Copyright and Disclaimer
©

Copyright 2019 Micro Focus or one of its affiliates.

The only warranties for this product and any associated updates or services are those that may be
described in express warranty statements accompanying the product or in an applicable license agreement
you have entered into. Nothing in this document should be construed as creating any warranty for a
product, updates, or services. The information contained in this document is subject to change without
notice and is provided "AS IS" without any express or implied warranties or conditions. Micro Focus shall
not be liable for any technical or other errors or omissions in this document. Please see the product's
applicable end user license agreement for details regarding the license terms and conditions, warranties,
and limitations of liability.
Any links to third-party websites take you outside Micro Focus websites, and Micro Focus has no control
over and is not responsible for information on third party sites.
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